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ABSTRAK

Sejak industri komunikasi dan teknologi maklumat berkembang dengan pesat
secara global, hampir kesemua kerja telah dipermudahkan dengan kemunculan
pelbagai perisian yang canggih. Kesemua perisian itu bukan sahaja membantu para
jurutera dalam menganalisis struktur dengan lebih cepat malah, dapat menghasilkan
keputusan yang tepat. Namun walaupun perisian-perisian ini mampu menghasilkan
keputusan analisis dengan cepat dan tepat, adalah amat penting bagi para jurutera
untuk mengetahui asas atau teori analisis dan bagaimana analisis itu dibuat. Perisian
perisian seperti LUSAS dan STAD PRO mampu menganalisis sebarang analisa jika
terdapat nilai-nilai parameter dan pembolehubah walaupun nilai-nilai tersebut salah.
Oleh itu, satu kajian telah dijalankan untuk mengetahui dan mengkaji analisis stuktur
yang dikenakan pelbagai jenis beban dengan menggunakan salah satu kaedah asas
untuk menganalisis struktur iaitu kaedah kekukuhan. Kaedah kekukuhan merupakan
kaedah moden bagi menganalisis struktur dan ia merupakan asas kepada kaedah
unsur terhingga. Kaedah unsur terhingga merupakan kaedah yang digunakan oleh
kebanyakan perisian analisis struktur seperti LUSAS. Objektif kajian ini ialah untuk
mengetahui dan mengkaji kaedah kekukuhan ini dan penggunaan ia terhadap struktur
kerangka yang terdiri daripada kekuda, kerangka dan rasuk. Struktur-struktur ini
dianalisa terhadap pelbagai beban yang merangkumi beban graviti dan beban yang
dihasilkan akibat daripada kesan ralat pembinaan, enapan dan perubahan suhu. Bagi
menyemak samada keputusan analisis yang dijalankan adalah benar, keputusan
analisis dengan menggunakan perisian LUSAS digunakan bagi membuat
perbandingan. Kesimpulannya, keputusan—keputusan daripada kedua-dua kaedah

analisis menghasilkan keputusan yang sama.
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ABSTRACT

Since the industry of information and communication technology has
grown rapidly and globally, almost all the works are being ease by the
emergence of various software. All those software are not only assisting the
engineers to analyse the structures quicker, but also can produce precise
results. But although the software can produce precise and instant result, it is
very important to acknowledge the basic of the applied operation and how the
analysis is being analysed. Software is able to analyse about anything if there
are inputs although they are wrong. Therefore, a study is conducted to
acknowledge and research the structure analysis with various kind of loading
by applying one of the famous methods to analyse structure which is stiffness
method. Stiffness method is a modern method for analyzing structures and it
is being used as the basic of finite element method. Finite element method is
the method which is being applied by many structure analysis softwares such
as LUSAS. The objective of this study is to acknowledge and researching the
stiffness method and its application to the structures which are consist of
frame, truss and beam. These structures are analyzed with various loadings
which consist of gravity loading and loadings which generated by the effect
of miss built of member, settlement and changes of temperatures. In
validating the results, LUSAS analysis is being done to compare the results
produced by stiffness method. As a result, it shows that both analysis

methods produced the same results.
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BAB1

PENDAHULUAN

1.1 Pengenalan

Pada masa kini, segala kerja telah dipermudahkan dengan perisian-perisian
yang canggih. Perisian-perisian ini bukan sahaja membantu jurutera dalam
menganalisis dengan cepat malah dapat menghasilkan keputusan dan hasil dengan
tepat. Namun begitu, adalah lebih bagus sekiranya mengetahui dan memahami

bagaimana perisian-perisian tersebuat dijalankan dan dipraktikkan.

Bagi pihak jurutera, tugas dan kerja mereka bukan sahaja sekadar
menjalankan analisis dengan memasukkan nilai-nilai tertentu sahaja. Malah, adalah
sangat berguna sekiranya jurutera mengetahui bagaimana operasi analisis itu
dilakukan agar dapat menggunakan perisian tersebut dengan lebih cekap dan

berkesan.

Oleh itu, projek ini cuba menjalankan kajian tentang proses analisis struktur
dengan menggunakan kaedah kekukuhan. Kajian ini cuba mengungkap apakah
terdapat perbezaan diantara analisis dengan menggunakan kaedah kekukuhan,
kaedah klasik dan analisis menggunakan perisian. Perisian yang akan digunakan
ialah perisian LUSAS. Perisian ini dibina berdasarkan analisis kaedah elemen

terhingga dimana asasnya adalah berdasarkan analisis kaedah kekukuhan.

Pada ketika ini, analisis struktur banyak membuat kajian yang melibatkan

struktur ditindaki beban kenaan dan beban graviti contohnya beban tumpu, beban



teragih dan momen. Namun, pada kali ini, projek ini akan membincangkan dan
membuat analisis terhadap kesan perubahan suhu, kesan terhadap ralat pembinaan
anggota dan kesan enapan pada sokong dengan menggunakan kaedah matrik

kekukuhan.

1.2 Penyataan masalah

Dalam mana-mana projek-projek pembinaan, analisis struktur diperlukan
bagi membantu para jurutera merekabentuk sesebuah struktur sehinggalah
keseluruhan bangunan atau projek. Bagi membantu dan memudahkan jurutera
menjalankan kerja rekabentuk dan analisis, perisian-perisian yang tertentu
diperkenalkan dan dipraktikkan selaras dengan kemajuan teknologi yang makin pesat

membangun. Salah satu perisian yang sering digunakan ialah perisian LUSAS.

Oleh itu, melalui kajian ini, kita akan dapat memberi justifikasi dan bukti
bagaimana sesuatu perisian itu menjalankan analisis struktur agar jurutera akan lebih
yakin mempraktikkan perisian. Malah, dapat menghargai ilmu yang telah dipelajari

terutama tentang analisis struktur.

Selain itu, melalui kajian ini juutera akan dapat memantapkan lagi
pemahaman tentang analsisi stuktur menggunakan kaedah matrik kekukuhan. Hal ini
demikian, analisis kaedah matrik kekukuhan ini merupakan asas kepada analisis yang

dijalankan oleh perisisan kini.

1.3 Objektif kajian.

Ia sangat penting untuk mengetahui secara mendalam analisis kaedah

kekekuhan terhadap struktur. Oleh itu, melalui kajian projek ini akan tercapailah

objektif sebenar projek ini iaitu :

a) Mengkaji dengan mendalam analisis struktur dengan menggunakan

kaedah kekukuhan.



b) Mengkaji penggunaan kaedah matriks kekukuhan dalam menganalisis
e Struktur-struktur yang berbeza.
e Struktur di bawah tindakan pelbagai daya dan berbeza daya.
e Struktur dengan kombinasi daya-daya yang berbeza.

c) Membandingkan analisis berdasarkan kaedah kekukuhan dengan

analisis daripada perisian LUSAS.

14 Skop kajian.

Dalam kajian ini, jenis-jenis struktur yang akan dikaji ialah kerangka satah,
rasuk selanjar, kekuda satah. Analisis yang dijalankan ditunjukkan melalui nilai-nilai

anjakan, daya ricih, daya paksi, momen hujung dan daya tindak balas pada sokong.

Kajian ini akan cuba mengungkap kesan tindakan beban akibat daripada
perubahan suhu, enapan pada sokong dan kesan ralat pembinaan anggota.
Seterusnya, akan cuba menganalisis berdasarkan kombinasi daya—daya yang berbeza

1tu.

Analisis yang dijalankan akan menggunakan kaedah kekukuhan dan
dibandingkan dengan kaedah analisis perisian. Perisian yang akan digunakan ialah

perisian LUSAS.

LUSAS merupakan perisian yang selalu dipraktikkan oleh jurutera untuk
menganalisis struktur. [a menganalisis berdasarkan kaedah elemen terhingga yang

pada dasarnya dan asasnya adalah kaedah kekukuhan.

1.5  Kepentingan kajian.

Kajian terhadap analisis struktur ini adalah sangat penting dan perlu
dilaksanakan kerana melalui analisis ini kita dapat mengenalpasti dan memberi kita
panduan untuk merekabentuk sesuatu stuktur. Melalui kaedah-kaedah analisis

struktur seperti kaedah matrik kekukuhan, kaedah unsur terhingga mahupun kaedah



klasik seperti kaedah momen dan beban unit, kita dapat membuktikan kesan tindakan
akibat pelbagai beban seperti beban kenaan, kesan perubahan suhu, kesan ralat

pembinaan anggota dan enapan pada sokong dan sebagainya.

Selain itu, hasil daripada kajian ini dapat membuktikan analisis yang
dijalankan oleh perisian-perisian melalui kaedah kekukuhan. Kini, pelbagai perisian
telah dikeluarkan bagi memudahkan jurutera menjalankan kerja-kerja mereka seperti
kerja merekabentuk, kerja menganalisis struktur, kerja merancang projek dan
sebagainya.antara perisian-perisian yang dipraktikkan oleh jurutrera ialah LUSAS,
Esteem, Staad Pro, Microsoft Project, Primavera dan sebagainya. Namun begitu,
dengan kajian ini kita dapat mengkaji bagaimana sesuatu perisian analisis seperti

LUSAS menjalankan analisis terhadap struktur.

Malah, melalui kajian ini dapat membuktikan dan mengetahui kesan tindakan
pelbagai beban selain daripada beban kenaan terutama beban graviti. Antaranya ialah
kesan tindakan beban akibat ralat pembinaan, kesan perubahan suhu dan kesan
enapan pada sokong. Sebelum ini, analisis banyak tertumpu terhadap kesan akibat
beban kenaan graviti. Namun, kesan beban akibat daripada suhu, ralat pembinaan
dan enapan pada sokong boleh mempengaruhi kestabilan struktur. Melalui kajian ini,
kita dapat menghargai dan menyedari betapa pentingnya pengaruh suhu, ralat

pembinaan dan enapan pada sokong terhadap kestabilan struktur.



BAB II

KAJIAN LITERATUR

2.1 Pengenalan kajian literatur

Pada masa dahulu, struktur-struktur dianalisis dan direkabentuk berdasarkan
pengalaman perekabentuk. Malah, sebelum wujudnya kaedah analisis struktur yang
khusus kesesuaian rekabebtuk dinilai berdasarkan perlakuan struktur setelah struktur
itu siap dibina dan digunakan. Dan sekiranya tedapat atau berlaku kecacatan,
kerosakan atau kekurangan, kerja-kerja pengubahsuaian dijalankan terhadap struktur
yang terlibat. Berdasarkan pengalaman empirikal ini, bermulalah satu titik permulaan

bagi analisis struktur berkembang.

Dengan merujuk kepada pengalaman-pengalaman yang didapati, ahli-ahli
matematik dan perekabentuk telah berusaha untuk meningkatkan lagi kaedah analisis
struktur. Malah, permintaan terhadap kaedah analisis yang lebih berkesan telah
meningkat dengan pesat sehingga timbul minat ahli-ahli matematik dan perekabentuk
untuk mencipta dan menerbitkan kaedah analisis struktur yang lebih berkesan dan

lebih khusus bagi menyelesaikan masalah-masalah mengenai struktur.

Seterusnya, terbitlah dan timbullah beberapa penemuan dan pembaharuan
mengenai analisis struktur. Kaedah analisis yang digunakan lebih khusus dan lebih
berkesan. Para ahli matematik telah berjaya menimbulkan beberapa kaedah analitikal
seperti kaedah beban unit, kaedah pengagihan momen, kaedah kebolehlenturan dan

sebagainya.



Saban tahun para ahli matematik dan perekabentuk mengkaji kaedah yang
lebih khusus dan berkesan dan akhirnya timbullah kaedah kekukuhan dan kaedah
unsur terhingga. Kaedah ini juga dipermudahkan dengan menggunakan dan
mempraktikkan pendekatan numerikal melalui kaedah matriks. Malah, dengan
berkembangnya teknologi yang canggih, keupayaan pengiraan analisis struktur yang
rumit dapat diselesaikan dengan mudah dengan menggunakan penemuan teknologi
komputer. Kaedah-kaedah moden ini bukan sahaja membantu para jurutera
menyelesaikan masalah struktur yang rumit, malah membantu para jurutera

menyelesaikannya dengan masa yang singkat.

2.2 Kaedah Analitikal Klasik

Kaedah analitikal klasik tidak seharusnya diabaikan dan ditinggalkan begitu
sahaja memandangkan penggunan pelbagai perisian komputer sudah menjadi
kelaziman dan kebiasaan. Kaedah analitikal klasik masih boleh memberi sumbangan
dan peranan yang penting kepada para jurutera terutama sebagai satu cara bagi
menyemak penyelesaian yang telah dijalankan melalui perisian mahupun kaedah
kekukuhan dan kaedah unsur terhingga. Kaedah klasik yang dimaksudkan ialah

kaedah beban unit dan kaedah agihan momen.

23 Pengenalan Kaedah Matrik Kekukuhan

Bagi menganalisis struktur berdasarkan kaedah matrik, terdapat dua kaedah
utama iaitu kaedah kebolehlenturan dan kaedah kekukuhan. Namun begitu,
pendekatan analisis struktur menggunakan kaedah matrik kekukuhan lebih meluas.
Malah, kebanyakan perisian di pasaran dan yang digunakan adalah berdasarkan
kaedah matrik kekukuhan. Perbezaan utama diantara kedua-dua kaedah analisis ini
ialah bagi kaedah kekukuhan, ialah anjakan nod yang tidak diketahui akan dicari
dahulu kemudian daya-daya yang berkaitan seperti tindak balas,ricih, momen dan
daya paksi diselesaikan dan dianalisis menggunakan nilai anjakan nod itu. Berlainan

dengan kaedah kebolehlenturan, kaedah ini mencari daya-daya yang tidak diketahui



dahulu kemudian dengan menggunakan daya-daya itu, anjakan pada sambungan dan

nod dapat diketahui.

24 Sejarah perkembangan kaedah matriks kekukuhan.

Analisis kaedah kekukuhan ini telah digunakan dan diperkenalkan sejak awal
1940-an. Ia bemula dan diperkembangkan dari teknik kemahiran analisis rangka
kepala terbang. Kemudian, dengan kajian yang berterusan kaedah kekukuhan ini
telah digunakan dan dipraktikkan untuk dan sebagai teknik penyelesaian masalah

dalam berbagai-bagai bidang kejuruteraan.

Perkembangan ini disebabkan oleh sifat-sifat kekukuhan itu sendiri sebagai
suatu kaedah analisis berangka yang sangat berkesan bagi menyelesaikan pelbagai

masalah dalam bidang kejuruteraan terutama dalam kejuruteraan awam.

Kaedah kekukuhan ini telah bermula pada tahun 1941 dimana A. Heinikoff
telah membuat anggapan dan kesimpulan iaitu yang struktur selanjar boleh
dibahagikan kepada unsur tehingga. Setiap unsur-unsur ini bersambung pada nod
unsur atau titik unsur. Kesimpulan ini merupakan titik permulaan bagi perkembangan

kaedah kekukuhan.

Kemudian pada tahun 1954, Agris dan rakan-rakannya mengemukakan satu
siri kertas kerja yang membincangkan analisis struktur secara lelurus menggunakan
kaedah unsure terhigga. Mereka juga mndakwa bahawa teknik ini sesuai ditulis

dalam bahasa komputer sebagai analisa berkomputer secara automatik.

Dua tahun kemudian, Turne, Clough, Martin dan Jopp membuat kesimpulan
bahawa penyelesaian sebenar masalah tegasan satah dengan unsur segitiga dengan
ciri-ciri bahan boleh ditentukan daripada persamaan teori keanjalan lelurus bahan
tersebut.

Pada tahun 1963, Baseling, Melosh, Freijs de Veubike dan Jones telah

membuktikan bahawa kaedah unsur terhingga merupakan satu bentuk dari kaedah



Ritz dan mengesahkan kaedah kekukuhan adalah satu teknik analisis berangka umum

untuk selesaikan masalah keanjalan selanjar.

Detik bermulanya penyampaian meluas ialah pada tahun 1965 apabila
Zienkiewiez dan Cheung melaporkan bahawa kaedah kekukuhan boleh digunakan

dalam masalah untuk semua bidang yang boleh ditukarkan dalam bentuk pembezaan.

Sejak peristiwa bersejarah itu berlaku, penggunaan kaedah kekukuhan
bertambah meluas. Buktinya ialah pada tahun 1969, Szabo dan Lee telah
menunjukkan bahawa hubungan persamaan unsur dengan kaji daya struktur,
pemindahan haba dan kaji daya bendalir boleh dihasilkan dengan menggunakan

kaedah Glerkin.

Penggunaan kaedah ini semakin popular dan dianggap berkesan setelah
munculnya komputer digital berkelajuan tinggi. Selepas itu, analisis kaedah
kekukuhan dipraktikkan dengan bantuan komputer. Dengan cara ini, penyelesaian
analisis dapat dilakukan dengan ketetapan yang tinggi dan menjimatkan masa

analisis jika melibatkan struktur yang rumit,besar dan kompleks.

2.5  Analisis matrik kekukuhan bagi kekuda.

‘4E/ \ L {6

) ®

Rajah 2.1: Sistem pernomboran anggota dan nod.

: Sistem paksi koordinat sejagat



2.5.1 Anggota dan Nod

Berdasarkan kaedah matrik kekukuhan, anggota-anggota pada suatu struktur
sama ada kekuda, kerangka, rasuk dan sebagainya dimodelkan sebagai suatu unsur-
unsur garis yang bersambung pada suatu titik yang dipanggil nod. Setelah itu,
anggota dan nod ini akan diberi suatu sistem pernomboran bagi memudahkan
rujukan dibuat dalam analisis. Nod-nod bagi unsur-unsur tersebut diletakkan pada
pertemuan penyokong dan anggota dan sambungan antara anggota. Biasanya, di nod-
nod inilah tempat dan titik dimana daya dikenakan, anjakan linear dan anjakan

putaran hendak diketahui.

Jika dilihat pada rajah 1 di atas, menunjukkan satu contoh bagaimana suatu
sistem pernomboran anggota dan nod dibuat. Di dalam rajah ini, nombor yang
dibulatkan merupakan nombor nod manakala nombor yang berada di dalm kotak
segiempat merupakan nombor anggota. Pada setiap anggota, hujung mula dan hujung
akhir ditentukan dengan menggunakan anak panah pada anggota tersebut. Arah ini

adalah sangat penting kerana ia sangat penting dalam membuat analisis nanti.

Rajah 2.2 : Hujung mula dan hujung akhir dan paksi koordinat

setempat
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2.5.2 Sistem koordinat tempatan dan global.

Beban dan anjakan adalah kuantiti vektor. Oleh sebab itu, arah beban dan
anjakan perlu dikenalpasti dan ditentukan berdasarkan standard panduan paksi.
Terdapat dua sistem koordinat digunakan iaitu sistem koordinat tempatan dan sistem

koordinat sejagat.atau global

Sistem koordinat sejagat digunakan bagi menentukan arah daya-daya luaran
iaitu beban yang dikenakan dan daya tindak balas pada penyokong dan anjakan
luaran pada nod-nod. Sistem koordinat sejagat ini boleh dilihat pada Rajah 2.1.
Setiap struktur perlu mempunyai satu sistem paksi sejagat saja bagi memudahkan
nod dirujuk. Biasanya, paksi-x sejagat, pada arah mendatar dan paksi-y sejagat pada
arah menegak. Oleh itu, jika menggunakan hukum tangan kanan, paksi-z sejagat

adalah pada arah keluar pada satah atau bersudut tepat pada satah xy.

Sistem paksi setempat pula bertujuan untuk menentukan arah daya dalaman
sama ada ricih atau momen dan anjakan dalaman pada nod-nod. Setiap anggota pada
struktur akan mempunyai paksi setempat atau paksi x” dan y’ sendiri. Sistem

koordinat atau paksi x’ dan y’ ini boleh dirujuk pada Rajah 2.2.

2.5.3 Darjah kebebasan

Darjah kebebasan bagi kekuda adalah anjakan yang tidak diketahui. Secara
umumnya, terdapat dua komponen anjakan pada setiap nod bagi kekuda. Di dalam
analisis, anjakan yang tidak diketahui merupakan suatu perkara yang berubah-ubah
yang perlu ditentukan. Darjah kebebasan perlu mempunyai sistem pernomboran yang
betul. Sistem pernomboran darjah ini perlu bermula dengan darjah kebebasan yang
tidak diketahui dan kemudian disusuli dengan darjah kebebasan yang diketahui.
Umumnya, darjah kebebasan yang diketahui berlaku pada sokong dimana ia berada
dalam keadaan sekatan. Merujuk kepada Rajah 2.1, nombor 1 hingga 6 merupakan
darjah kebebasan yang tidak diketahui dan manakala nombor 7 dan 8 adalah darjah

kebebasan yang diketahui dimana niainya adalah sifar.
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2.5.4 Matriks kekukuhan

Kekukuhan anggota-anggota kekuda berfungsi berdasarkan panjang anggota,
luas keratan rentas dan modulus elastik. Setelah nod, anggota dan sistem
pernomboran darjah kebebasan telah ditentukan, matrik kekukuhan bagi anggota
boleh ditentukan. Kekukuhan anggota merupakan pekali hubungan di antara beban
dan anjakan yang berpandukan kepada sistem paksi setempat. Oleh kerana setiap
anggota mempunyai arah yang bebeza, daya dalaman dan anjakan yang berpandukan
kepada sistem paksi setempat perlu ditukar kepada paksi global atau sejagat.
Keadaan ini boleh dilakukan dengan menggunakan matrik transformasi daya dan
anjakan. Setelah itu, matrik kekukuhan anggota boleh ditukar dan ditransformasi dari
paksi setempat ke paksi global dan kemudian dutransformasi kepada matriz

kekukuhan struktur.

Terdapat dua kaedah bagi menjalankan kerja pertukaran matrik tersebut.
Kaedah yang pertama ialah dengan membentuk matrik kekukuhan anggota, k
berdasarkan sistem paksi setempat. Kemudian, gabung segala matrik-matrik untuk
segala anggota, kc. Gabungan matrik ini masih dalam keadan sistem paksi setempat.
Setelah itu, matrik kc itu ditransformasi kepada matrik kekukuhan yang berpandukan
pada sistem paksi global, K. Namun begitu, kaedah pertama ini tidak sesuai bagi
komputer untuk menganalisis kerana terdapat kesukaran dalam proses pertukaran
matrik, K untuk senua anggota kekuda. Secara ringkasnya, diagram di bawah

menerangkan kaedah pertama ini.

[k1]
[k2] combination = ke transformation = K
[k3]
[kn]
Local axis local axis global axis

Kaedah kedua pula berlainan dimana setiap kekukuhan anggota, k yang
berpandukan kepada paksi setempat ditukar kepada paksi global, K’.Seterusnya
kekukuhan anggota digabung kepada satu matriz yang dipanggil matrik kekukuhan



struktur, K. Secara ringksnya, diagram di bawah menunjukkan segala proses bagi

kaedah kedua ini.

k1] K'l
[k2] . K'2 .
transformation —> combination -
[k3] K'3
[kn] K'n
Local axis global axis global axis

2.5.5 Matrik kekukuhan anggota kekuda setempat

Pada nod A, anggota akan mengalami pemendekan sebanyak 04, akibat
daripada daya paksi f’ 4. ’g merupakan daya tindak balas pada B. Sekiranya, A, E
dan L adalah luas keratan rentas, modulus elastik dan panjang anggota, maka

hubungan diantara daya paksi dan anjakan boleh dirumuskan sebagai :

AE AE
a=——29 dan f'g=-— 90
A 1 A B 1 A

Nilai f’g adalah negatif kerana ia berarah negatif paksi-x.

Seterusnya, anggota yang sama dipertimbangkan tetapi dipin pada nod A
seperti ditunjukkan pada rajah 3(b). Akibat daripada daya paksi f’g pada nod B,
anggota akan mengalami pemanjangan sebanyak dg. Oleh itu, hubungan diantara

daya paksi dan anjakan boleh dirumuskan sebagai :

AE AE
f’A=-— 0 dan = — 9
A L B B L B

Daya sebenar pada A dan B diperoleh dengan superposisi:
fA = f’A + f’A
AE AE

fa= —— Sp-—— 8
A |_ A |_ B

12
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dan
fg=1p+ s
AE AE
fg= — 0g-— 9
L B L AC

Kedua-dua persamaan itu boleh ditulis dalam bentuk matrik:

fA _AE 1 —1|oA
B L|-1 1/|B
Atau,
f=ké
1 -1 AE/L —-AE/L k -k
k=E or k= atau k=| " 12
L|-1 1 —AE/L AE/L -k, k,

Matrik k, dipanggil sebagai matrik kekukuhan anggota. Simbol k;; bermaksud daya
pada nod i yang disebabkan oleh anjakan 0, = 1 ditentukan dengan i =j = 1, maka

AE
fa=ki = —
A= ki 1

2.5.6 Matrik transformasi daya

Oleh kerana, daya dalaman dan anjakan adalah berpandukan kepada paksi
setempat, maka adalah perlu untuk menukar sistem itu kepada sistem paksi global.
Pengiraan kos bagi sudut-sudut itu boleh ditentukan dengan mudah dan dinyatakan

sebagai A, dan A,, maka

Xp - Xa

Las VI(Xg —Xa) + (Y- Ya)]

Ay = (X = koordinat),ed akhir — (X — koordinat)nod mula

panjang anggota
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Yg - Xa

Lap VI(Xs —Xa) + (Yp— Ya)]

Ay = (Y —koordinat),ed akhir — (Y — koordinat)ned mula

panjang anggota

2.5.7 Matrik transformasi anjakan

Sekiranya anggota AB dimana dipin pada B dipertimbangkan, nod A
mengalami anjakan pada arah x dan y (dua darjah kebebasan dalam sistem paksi
global), contohnya A, dan A,y . Anjakan dalam paksi-x boleh ditentukan dengan

menambah komponen anjakan Axx dan Aay pada paksi-x.

da = Aaxkos 05 + Apykos 0y

Sekiranya, nod pula dipin, nod B pula akan mengalami anjakan pada arah x

dan y iaitu Aax dan A,y . Maka,

Ag = Agykos 0 + Agykos 0y

Dengan A, = kos 0, dan A, = kos 0,
0A = Aax A T+ AAy }\,y
SB = ABX }\.X + ABy >\,y

Dan sekiranya ditulis dalam bentuk matrik

Aax
Aay
Abx
Aby

Atau

o7
Il

TA
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dimana

o Ay 0 0
0 0 Ay Ay

T B ‘
T merupakan matrik yang berfungsi menukarkan empat anjakan, A kepada
dua anjakan setempat, 5. Oleh itu, T dipanggil sebagai matrik transformasi anjakan.
2.5.8 Matrik kekukuhan global anggota bagi kekuda
Matrik kekukuhan global anggota kekuda ditentukan daripada hubungan
antara matrik daya luaran F dan matrik daya dalaman A. Dengan memasukkan
formula & = kT kepada formula f = ko, maka

F=kTA

Dan dengan memasukkan rumus in ke dalam rumus F = T 'f, maka

F=T'kTA
Atau F=K’A
Dimana
K’ =TkT
AX 0
’ Ay 0 AE 1 -1 AX Ay 0 0
K= 1o /S S I DR 0 0 AX Ay
0 Ay

Ax Ay -AxE -AxMy
AE Ahy  A’X Axhy - Ay’
- L At -AxAy AXE AxAy
“axAy -Ayt AxAy  Ay?
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2.5.9 Matrik kekukuhan struktur kekuda

Setelah matrik kekukuhan anggota dalam sistem paksi global, K’ ditentukan,
langkah setrusnya ialah menentukan matrik kekukuhan struktur bagi kekuda, K iaitu
dengan menggabungkan matrik K’ setiap sanggota ke dalam satu matrik. .Semasa
membentuk matrik K, setiap unsur di dalam matrik K’ akan diletak pada lajur dan
baris yang sama denagn matrik K. Oleh itu, akan trdapat beberapa unsur-unsur yang
bertindih darjah kebebasannya di dalam matrik K. Namun begitu unsur-unsur in

boleh dijumlahkan secara algebra.

2.5.10 Penggunaan kaedah kekukuhan terhadap analisis kekuda satah

Matrik kekukuhan yang telah diterbitkan akan digunakan bagi menentukan
anjakan pada nod, daya tindak balas sokong dan day paksi. Pertama sekali, matrik
anjakan dibahagikan kepada dua bahagian iaitu yang di atas sekali ialah untuk
anjakan yang tidak diketahui, Au danyang di bawah ialah untuk anjakan yang
diketahui, Ak (biasanya bernilai sifar). Kemudian beban yang dikenakan dipisahkan
diantara kuantiti yang diketahui, Fk dan daya tidak balas, Fu.

Fk _ K Ki» AU
Ful Koi Kn Ak

Dimana
Fk dan Ak : daya dan anjakan luaran yang diketahui.
Fu dan Au : daya dan anjakan luaran yang tidak diketahui.
K : matrik kekukuhan struktur
Persamaan in boleh dileraikan menjadi
Fk =K;; Au + K, Ak
Fu=Kj;; Au + K5, Ak
Jika sokong tidak mengalami enapan maka nilai Ak= 0. seterusnya persamaan in
menjadi

Fk:Kll Au
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Atau

-1

Fk

Persamaan di atas memberikan penyelesaian untuk semua anjakan-anjakan yang
tidak diketahui pada semua nod. Dengan memaukkan persaman in kepada persaman

Fu=K5; Au+ Ky Ak

Maka
Fu =K, Au =Ky, ’K“ ‘ ©Fk

Persaman ini berfugsi untuk menetukan daya tidak balas sokong. Daya di dalam

anggota ditentukan daripada persamaan

F=kTA

Taitu

Aax

Ax Ay 0 0 Aay
0 0 AX Ay Abx

Aby

T

Jika ingin menentukan daya fg, diketahui persamaan keseimbangan f, = - 5, maka

Aax

AE Aay
fg= — | A A 0 0

i L * Y Abx

Aby

Sekiranya nilai fg yang diperoleh adalah bernilai positif, maka anggota itu mengalami

tegangan dan juga sebaliknya.
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2.5.11 Kesan perubahan suhu dalam analisis kekuda

Jika berlaku penambahan atau pengurangan suhu, AT akan berlaku
pemanjangan atau penguncupan pemanjangan anggota sepanjang AL dengan a iaitu
pekali pengembangan suhu.

AL =q (AT)L

Oleh itu, untuk mengatasi dan mengurangkan pemanjangan tersebut, suatu
daya mampatan fo dikenakan kepada anggota. Daya mampatan ini akan
mengurangkan panjang anggota sebanyak

AL’ =fo L/ AE.

Maka akan diperoleh nilai daya mamapatan fo

fo=AE o AT

Daya mampatan in akan bertindak sebagai daya hujung terikat yang
memberikan halangan kepada kedua-dua nod anggota tersebut seperti yang
ditunjukkan dalam rajah, maka akan diperoleh

(fa)o = AE a (AT)

(fs)o =-AE a (AT)

Sekiranya berlaku penurunaan suhu, (AT) akan bernilai negatif maka arah

daya-daya akan bertukar untuk mengekalkan keseimbangan angota.

fr

=<AEa(AT){1£

Seterusnya, dengan menggunakan persamaan daya global

F=T'f
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Daya-daya mampatan ini diubah kepada sistem koordinat global yang mana akan

menghasilkan
Fnx Ax0
Fny Ay 0 1
Fex | = 0 Ax AE a (AT) .
Fry 0 Ay
AX
Ay
= AEa(AT) | )k
- Ay

2.5.12 Kesan ralat pembinaan dalam analisis kekuda

Sekiranya suatu anggota kekuda dibina dengan terlebih panjang sebanyak AL
walaupun anggota tersebut belum dipasangkan bersama dengan anggota-anggota
yang lain, maka akan berlaku daya mampatan, fo iaitu

fo=AE (AL)/L

fao=AE (AL)/L

fsgo=AE (AL)/L

bagi mengurangkan pemanjangan tersebut. Dan sekiranya anggota dibina lebih
pendek daripad yang direkabentuk, maka pemanjangan, AL akan bernilai negatif dan
seterusnya mengakibatkan arah kedu-dua daya akan bertukar arah bagi mengekalkan
keseimbangan anggota.

Oleh yang demikian, daya global boleh diterbitkan dan diperoleh iaitu

F=T'f
(Fax)o AXx
(Fay)o Ay
(Fex)o | = AE(AL)/L - AX

(Fey)o - Ay
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2.5.13 Analisis matrik kekuda yang mengalami perubahan suhu dan ralat

pembinan

Bagi kekuda yang mengalami perubahan suhu dan ralat pembinaan,
hubungan daya dan anjakan ialah

F=KA+Fo
Fo adalah matrik lajur bagi daya-daya hujug terkat akibat perubahan suhu dan ralat

pembinaan anggota bagi keseluruhan kekuda. Unsur-unsur dalam persamaan ini

)

Dengan mengembangkan matrik di atas melalui pendaraban matrik , diperoleh
Fx=Kj; Au + K, Ak + (Fk)o
Fu=Kj;; Au+ Ky, Ak + (Fk)o

diasingkan dalam bentuk matrik iaitu

(Fxo

Fy
(Fuo

Fy

_| KI1 KI2
K21 K22

Anjakan yang tidak diketahi Au boleh ditentukan dari persamaan di atas denagn
menolak (Fk)o di kedua-dua belah persamaan dan seterusnya menyelesaikan
persamaan yang terhasil bagi memperolehi Au. in menghasilkan

Au=K;;" (Fc - Kz Ak — (Fi), )

Seterusnya, daya-daya dalam anggota ditentukan melalui proses superposisi

f=kTA +qo

Bagi menentukan daya hujung, fz pada sesuatu anggota

Aax
AE AX Ay 0 0 Aay
fg= — - (f
. L Abx (fa)o
Aby

(fs )o mewakili daya hujung terikat akibat dari perubahan suhu atau ralat pembinaan.
Sekiranya fsyang dihitung bernilai negatif maka anggota mengalami daya

mampatan dan begitu juga sebaliknya
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2.6 Analisis matrik kekukuhan bagi anggota kerangka dan rasuk

2.6.1 Identifikasi anggota dan nod

Nod terletak pada sokong, hujung anggota, sambungan, daya tumpu luaran
dan dititik di mana anjakan linear atau putaran ditentukan. Bagi memudahkan
analisis, nod dinomborkan di dalam bulatan manakala anggota dinomborkan di
dalam petak segiempat. Selain itu, adalah penting untuk mengidentifikasi hujung
mula dan akhir untuk setiap anggota. Oleh itu, hujung mula dan akhir ditentukan
dengan menggunakan arah panah yang diletakkan bersama-sama pada setiap

anggota.

2.6.2 Koordinat global dan setempat anggota

Sistem koordinat paksi global struktur dikenalpasti dengan menggunakan
paksi x, y, z. Manakala system koordinat setempat sitentukan dengan menggunakan
paksi x’, y’, z° dan ia mempunyai titi permulaan pada hujug mula setiap anggota.

Kedua-dua system koordinat ini menggunakan hukum tangan kanan.

2.6.3 Darjah kebebasan

Dengan mempertimbangkan kesan daya paksi dan momen lentur, setiap nod
anggota kerangka mempunyai tiga darjah kebebasan iaitu dua anjakan linear dan satu
anjakan putaran. Anjakan ini dikenalpasti melalui sistem pernomboran tersendiri.
Nilai nombor yang terendah digunakan untuk mengenalpasti anjakan yang tidak
diketahui dan nombor yang tertinggi digunakan untuk menunjukkan anjakan yang

diketahui.

Bagi rasuk, kesan paksi dan daya ricih pada rasuk diabaikan. Oleh itu, setiap

nod rasuk akan mempunyai satu darjah kebebasan iaitu anjakan putaran.
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2.6.4 Beban pada anggota

Berdasarkan hukum superposisi, daya atau beban teragih seragam boleh
ditunjukkan melalui daya pada nod anggota dan daya tindak balas sokong yang diikat
tegar akibat daripada beban anggota.

Dengan menggunakan superposisi, hubungan beban atau daya — anjakan adalah

gNX'| AE/L 0 0 -AE/L 0 0
gNy' 0 12ELL’ 6EI/L? 0 -12E/L? 6EI/L?
Ng' 0 6EI/L? AEI/L 0 -6EI/L? 2EI/L
A2 _ 1 LABL 0 0 AE/L 0 0
qFx' 0 -12EI/L? -6EI/L? 0 12EI/L? -6EI/L?
qFy' 0  G6EIL’ 2EI/L 0 -GEI/L? 4EI/L
| qFZ'

[gNXx'|

aNy'

< | ANz’

gFx'

qFy'

| 9FZ' |
Atau
q=k’d

dengan q = daya dalaman anggota
k> = matrik kekukuhan anggota

d = anjakan anggota

2.6.5 Matrik anjakan

Bagi menukar anjakan global, D kepada anjakan setempat, kaedah kekukuhan

menggunakan matrik transformasi anjakan iaitu




dNx x Ay 0 0 0
dNy' Ay A 0 0 0
dNz' 0 0 10 0
= 0 0 0 Aix A
dFx' y
' 0 0 0 -Ay Ax
dFy O 0 0 0 0
| dFZ' |
Atau
d=TD

D = anjakan dalam system global
T = anjakan dalam matrik transformasi

d = anjakan anggota dalam sistem setempat

2.6.6 Matrik daya

Bagi menukar daya dalaman anggota daripada sistem setempat x’, y’, z

kepada system koordinat x, y, z.

Q=T'q
Q = daya dalam sistem global
T T = matrik transformasi daya

q = daya anggota dalam sistem setempat

QNxX'

\ AX Ay 00 0
QNy, AX X 0 0 0
QNI 19 o 1 0o o
QFX' 0 0 0 Ax Ay
QFy' 0 0 0 A Ax
OF7 0 0 0 0 0

—_0 O O OO

—_o OO oo

23
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2.6.7 Matrik kekukuhan global anggota bagi kerangka

Dengan mengambil kira , hubungan beban atau daya — anjakan, matrik

anjakan dan matrik daya iaitu

q=kd
d=TD
Q=T'q

Akan menghasilkan

Q=k’TD

Dan dengan menolak rumus di atas dengan rumus matrik daya, maka

Q=T'kKTD

Q=kD
Dimana

k=T'kK’T

= matrik kekukuhan global untuk anggota

2.6.8 Matrik kekukuhan global anggota bagi rasuk

Sekiranya rasuk tidak mengalami enapan dan rasuk tidak mempunyai anggota
yang tergantung, maka setiap rasuk mempunyai satu darjah kebebasan iaitu anjakan
putaran.Oleh kerana daya paksi dan anjakan paksi tidak dipertimbangkan maka

matrik kekukuhan global untuk anggota rasuk ialah

_|4El/L 2EI/L
2ElI/L 4El/L

Dan oleh kerana putaran tidak ditukar atau ditransformasikan, maka

k=k’T
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2.6.9 Penggunaan kaedah kekukuhan dalam analisis kerangka dan rasuk

Sebagai panduan, struktur perlu diperkenalkan dengan nod dan garis bagi
mewakili bentuk struktur sebenar. Oleh itu, nod perlu diperkenalkan pada sokong,
hujung anggota, sambungan, daya tumpu dan titik di mana anjakan atau enapan

ditentukan.

Selain itu, adalah sangat penting untuk memberi nombor kepada nod-nod
tersebut seperti yang dilakukan pada kekuda. Titik permulaan paksi global perlu
ditentukan dahulu di mana. Malah, semua koordinat untuk setiap nod perlu merujuk
pada titik permulaan paksi global. Adalah sangat mustahak juga arah anggota

ditentukan bagi menunujukkan arah positif paksi setempat.

Seterusnya, sistem pernomboran kepada darjah kebebasan dibuat iaitu
bermula dengan darjah yang tidak dikeahui dan diikuti dengan darjah kebebasan
yang diketahui.

Daya-daya pada nod boleh dihubungkaitkan dengan menggunakan persamaan
kekukuhan struktur
F=KA

Dimana diperoleh dengan mengsingkan matrik kekukuhan, K kepada daya

serta anjakan yang diketahui dan yang tidak diketahui
Fu K 21 K 22 A K

Dan jika dikembangkan akan menghasilkan dua persamaan
Fie =K1 Ay + Kz Ak
Fu =Ko Au+ Koo Ax

Anjakan yang tidak diketahui A, ditentukan daripada persamaan pertama.
Dengan menggunakan nilai anjakan yang diperolehi, daya tindak balas sokong Fu

dikira menggunakan persamaan kedua.
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Bagi kerangka daya-daya pada hujung anggota ditentukan menggunakan hubungan
f=kTA (untuk struktur kerangka)
f=K’A (untuk struktur rasuk)

Bagi menentukan daya dalaman anggota, q

q=k’TD
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BAB III

ANALISIS BERKOMPUTER MENGGUNAKAN LUSAS

3.1 Analisis berkomputer

Pada masa kini, analisis-analisis yang dijalankan kebanyakannya dilakukan
dan dijalankan dengan mengaplikasikan penggunaan komputer. Hal ini adalah
memandangkan kepesatan teknologi yang sangat cepat berlaku terutama dalam
bidang teknologi maklumat. Analisis-analisis itu tidak kira samada dalam bidang
kejuruteraan, perubatan, alam sekitar, ekonomi dan sebagainya dijalankan dengan

berpandukan dan berbantukan perisian komputer.

Perisian-perisian yang telah dibina dan dimajukan dapat dan mampu memberi
kemudahan kepada jurutera dalam menganalisis struktur dengan mudah dan cepat
selain menjalankan eksperimen atau kajian di makmal. Perisian-perisian untuk
analisis struktur yang telah berada di pasaran adalah seperti LUSAS, StadPro,
COSMOS-M, NASTRAN, ABAQUS, ANSYS. Hasil-hasil analisis daripada
perisian-perisian ini boleh membantu jurutera menjangka kesan-kesan yang akan

berlaku apabila kajian makmal dijalankan.

Dalam kajian ini, perisian yang digunakan adalah perisian yang
mengaplikasikan kaedah unsur terhingga iaitu perisian LUSAS. Kaedah unsur
terhingga merupakan kaedah yang digunakan bagi menganalisis struktur yang
kompleks seperti struktur kerangka pesawat udara, struktur yang tidak seragam,

struktur yang mempunyai banyak anggota dan sebagainya.
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3.2 Konsep asas kaedah unsur terhingga

Kaedah ini diasaskan daripada idea pembinaan blok tanah liat oleh orang-
orang Babylon. Idea ini diaplikasikan oleh ahli matematik dengan menggunakan
kaedah anggapan geometri untuk mendapatkan panjang ukur lilit satu bulatan dengan
mencantumkan beberapa garis lurus di sepanjang ukur lilit bulatan dan
menjumlahkannya. Hasil daripada konsep ittu, nilai & ditentukan. (Zainudin Taib,

Analisis Struktur 2003).

Konsep asasnya ialah menyelesaikan masalah struktur yang kompleks dengan
memecahkannya kepada beberapa masalah yang lebih kecil. Oleh itu, sesuatu
struktur itu dibahagikan kepada beberapa bentuk bahagian atau dipanggil elemen
yang lebih kecil dan analisis setiap bahagian atau elemen yang telah dibahagikan itu.

Justeru itu, kaedah ini sesuai digunakan untuk struktur yang kompleks.

3.3 Jenis elemen

Kebiasaannya, elemen dikelaskan berdasarkan kepada dimensi elemen, darjah
kebebasan, darjah polinomial, bentuk dan keselanjaran antara unsur. Darjah
polinomial ditentukan oleh polinomial lengkap yang tertinggi dan bukannya darjah
sebutan tertinggi. Jadual 3.1menunjukkan pengelasan unsur yang boleh dilakukan
manakala rajah menunjukkan jenis-jenis elemen. Rajah 3.1 pula menunjukkan contoh

jenis-jenis elemen unsur terhingga.
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Dimensi Darjah Darjah Bentuk Keselanjaran
kebebasan polinomial antara unsur
Garis Satu Linear Lelurus Fungsi
Permukaan Dua Kuadratik Segitiga Kebezaan
pertama
Pejal Tiga Kubik Segiempat Kebezaan
kedua
Jadual 3.1  Pengelasan elemen




30

2

Rasuk (elemen linear)

3
Kuboid (elemen pejal)

2

Kekuda (elemen linear)

Kuboid (elemen permukaan)

Rajah 3.1

Jenis-jenis unsur terhingga
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3.4 Perisian LUSAS

Perisian LUSAS adalah singkatan bagi London University Structural
Analysis System. Ia berkemampuan untuk menganalisis pelbagai jenis struktur
dengan geometri yang kompleks. Kelebihan perisian ini ialah ia berupaya untuk
menganalisis struktur yang dikenakan beban dinamik dan fabrik, struktur pra-

tegasan, struktur tidak linear, struktur kabel, truktur jambatan dan lain-lain.

LUSAS adalah perisian dimana boleh membentuk model dan mendefinisikan
geometri, bahan, sokong, dan bebannya. Ketepatan sesuatu keputusan dan hasil
analisis bergantung pada bilangan unsur atau elemen yang dibahagikan. Hal ini

demikian, ia mempraktikkan kaedah unsur terhingga.

3.4.1 Permulaan

Sebagai permulaan bagi menganalisis sesuatu struktur menggunakan perisian
LUSAS, penyediaan fail baru perlu dilakukan terlebih dahulu. Fail baru dibina
dengan menggunakan arahan menu File > New. Satu kotak dialog akan terpapar pada
skrin seperti yang ditunjukkan pada Rajah 3.2 Fail baru ini diberi nama PSM2007
dan nama model dinamakan sebagai model kekuda satah. Kemudian, penetapan unit

semasa analisis perlu dilakukan di sini.

Dalam pembinaan model ini, unit yang dipraktikkan adalah kKN m t C s. Untuk
bahagian Vertical axis, digunakan bagi menetapkan paksi yang menegak. Oleh itu,
paksi-y ditetapkan sebagai paksi menegak. Setelah selesai membuat semua

penetapan, tekan OK.
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"
Mew Model Startup

—File detailz

File name I

“whorking falder f* Default " Last uzed i~ User defined

Savein I C:Luzas1364Projects |

— b odel details
Title I

I itz I kM mtC s j Job Mo I

Startup templatEI Ware j Veticaldwis v vy @7

QK | Cancel | Help

Rajah 3.2 Kotak dialog bagi membina fail baru

Penyemakan unit yang telah ditetapkan perlu dibuat agar dapat memastikan
analisis yang dijalankan menggunakan unit yang dikehendaki. Oleh itu, bagi
menyemak unit yang telah ditetapkan, guna arahan File>Model Properties. Kotak
dialog Properties akan terpapar dan pilih menu Geometry seperti yang ditunjukkan
pada Rajah 3.3.dan 3.4 Paparan baru akan wujud dimana menunjukkan kotak dialog
Geometry. Penukaran dan penyemakan unit boleh dilakukan disini. Setelah itu, fail
baru yang telah dibina disimpan dengan menggunakan arahan menu Save atau Save

as.
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- 3

Froperties

General Geometry |Meshing| Attributesl Snlutinnl Confirmation_4 | ’l

— Merge
Tolerance IlE-3 Characteristics IExact j

[T Make Mew Features Unmergable

—Adcive local coordinate set

D atazet ;I

Units... | Advanced...

0k Cancel Apply | Help

Rajah 3.3 Kotak dialog Properties

System Units

(] 4 I Cancel | Help |

Rajah 3.4 Kotak dialog bagi penyemakan unit

3.4.2 Pembinaan model

Bagi memudahkan penerangan cara penggunaan LUSAS dalam menganalisis
struktur, kekuda satah digunakan sebagai rujukan. Langkah permulaan dalam
pembinaan model ialah menetapkan koordinat-koordinat bagi nod-nod atau sokong-
sokong struktur kekuda ini. Penetapan koordinat-koordinat ini dilakukan dengan
menggunakan arahan menu Points. Paparan kotak dialog akan wujud seperti

ditunjukkan pada Rajah 3.5 dan di sinilah koordinat-koordinat sokong ditetapkan.
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Bagi menambah koordinat pada kotak dialog ini, tekan Tab. Setelah selesai

menetapkan koordinat, tekan OK.

-
Enter coordinates

— [anid style
W 3 Columnsz
X | Y z
1 q| 3 0
2| 4 B 0
3 | 4 3 0
4] 0 0 0

— Local coordinate set
| =l

[T Keep as reference set

| k. I Cancel | Help |

Rajah 3.5 Arahan menu Points

Bagi menyambung koordinat-koordinat yang telah ditetapkan itu, arahan
menu Line digunakan. Sebelum menggunakan menu Line, titik-titik atau koordinat-

koordinat yang hendak disambung dipilih dahulu. Kemudian, tekan menu Line.

3.4.3 Penetapan Attributes

Model yang telah selesai dibina, perlu disetkan dan dimasukkan nilai-nilai
geometri, beban dan bahan struktur. Selain itu, sokong struktur dan bilangan pecahan

elemen perlu ditetapkan dalam menganalisis struktur kekuda satah ini.
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3.4.4 Penetapan elemen

Perkara pertama yang amat mustahak yang perlu ditetapkan adalah penetapan
bilangan pecahan elemen dan jenis elemen. Penetapan ini amat penting kerana
perisian LUSAS mempraktikkan konsep kaedah unsur terhingga dimana anggota
struktur dipecahkan kepada beberapa elemen atau unsur bagi memudahkan kerja
analisis dijalankan. Justeru itu, arahan menu Attributes > Mesh > Line digunakan.

Rajah 3.6 menunjukkan paparan kotak dialog Mesh.

o

Eclit Attribute

Line Mesh

¥ Element description e Mumber of divisions

Generic element type

IEar j

Mumber of dimensions

|2 dimensional j Spacing...

Interpolation order

I

ILinaar j " Element length

{~ Element name

End releases... |

1

D atazet ILine Mezh 1 LI

Cloze I Cancel Apply | Help |

Rajah 3.6  Kotak dialog Mesh

Untuk anggota struktur kekuda satah, elemen bar dipilih. Jika hendak
menganalisis rasuk, elemen Thick Beam dipilih. Kemudian, tetapkan bilangan

elemen yang perlu dibahagikan ada anggota struktur kekuda satah ini. Di sini,
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anggota kekuda satah ini dipecahkan kepada 4 elemen. Semakin banyak elemen

dibuat, semakin tepat dan jitu keputusan analisis yang akan diperolehi.

3.4.5 Penetapan Geometri

Penetapan geometri dilakukan bagi memberi nilai-nilai yang berkaitan
tentang geometri struktur seperti keratan rentas luas struktur, momen inersia dan
sebagainya. Penetapan dilakukan dengan menggunakan arahan menu Attributes >
Geometry > Line. Memandangkan telah menetapkan elemen bar sebagai elemen bagi
kekuda satah ini, pilih bahagian Bar/Link. Oleh itu, setkan keratan rentas luas
anggota struktur dengan nilai 0.5 x 10~ m. Kemudian, namakan penetapan ini.

Ini boleh merujuk pada Rajah 3.7

Line Geometry
Cross Section Beam I Axisymmetric plate / shell
Bar/ Link Grillage | Thick Beam Thin Beam
Value
Crozs sectional area (A 0.5E-3
D ataset IBar;"Link 1| LI
ak. I Cancel | Apply | Help

Rajah 3.7 Kotak dialog penetapan geometri



3.4.6 Penetapan Bahan
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Penetapan bahan adalah bermaksud menetapkan nilai-nilai bahan yang

membina struktur kekuda satah itu. Dalam keadaan ini, isotropik dipilih. Nilai nisbah

Poisson, Modulus Keanjalan dan ketumpatan jisim ditetapkan. Bagi kekuda ini, nilai

Modulus keanjalan ialah 200 x 10° m*. Oleh itu, arahan menu Attributes > Materials

> |sotropik digunakan. Jika kekuda satah dianalisis terhadap kesan perubahan suhu,

ikon thermal expansion dipilih bagi menetapkan kadar pengembangan suhu. Kadar

pengembangan suhu bagi kekuda ini ialah 1.5 x 10” . Rajah.3.8 menunjukkan kotak

dialog menu Materials

Eclit Attribute
Isotropic I

Using the following propertie:

Elastic |

[~ Wiscous [~ Two phase

W Thermal expansion

I~ Plastic [ Creep [~ Damage
Value |
Young's modulus 200EG
Poiszon's ratio u]
Maz= density u]
Coefficient of thermal expansion 0.0 5E-3

[T Dynamic properties

Datazet |lsotropic Material 1

El

Rajah 3.8

Kotak dialog Materials




3.4.7 Penetapan soko

Penyokong anggota struktur ditetapkan dengan menggunakan arahan menu

ng
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Attributes > Support > Structural. Bagi menetapkan sokong pin, anjakan pada semua

arah disetkan agar tidak berlaku dan tetap. Kemudian, sokong ini diberi nama pin

seperti mana yang ditunjukkan pada Rajah.3.9

Eclit Attribute

Structural Supports

Free Fixed Spring stiffness
X . o o I
Translation in i - ey ' I
z - = ‘» |
X = T o I
Rotation about ¥ i - ' I
z @« - - |
Hinge rotation oy e ' I
Pore pressure (= ' ' I

{= Stiffness

r Spring stiffness distribution

" Stiffnessfunit length

{~ Stiffnessfunit area

Datazet |pin

=l

Cloze I Cancel

| Apply

Help

Rajah 3.9  Penetapan sokong pin

Bagi sokong rola, anjakan pada arah normal disetkan sebagai tetap dan tidak

berlaku. Manakala, bagi sokong diikat tegar, semua anjakan disetkan tetap dan

putaran juga disetkan tetap. Rajah 3.10 menunjukkan sokong rola disetkan.
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Edit Attribute

Structural Supports

Free  Fixed Spring stiffness
X . o r
Translation in W ¥ i f"
rd i« e r
X « . .
Rotation about ¥ = . .
Fid « . .
Hinge ratation 0 . .
Pore pressure v r i
— Spring stiffness distribution
¥ Stiffness € Stiffness’unit length € stiffness/unit area
Dataset [roller ;I

| Cloze I Cancel Apply | Help

Rajah 3.10  Penetapan sokong rola

3.4.8 Penetapan beban

Beban disetkan dengan menggunakan arahan menu Attributes > Loading.
Bagi menetapkan beban tumpu, beban teragih seragam atau perubahan suhu, menu
Structural dipilih. Untuk menetapkan beban tumpu, menu concentrated dipilih. Nilai

beban sebanyak -100kN disetkan pada paksi-y. Tanda negatif (-) disetkan
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menandakan arah beban tumpu menuju ke arah bawah pada paksi-y.

Rajah.3.11menunjukkan beban tumpu disetkan pada kotak dialog beban struktur.

Structural Loacing Datasets

Temperature I Stress and Strain | Internal Beam Point
Internal Beam Distributed | Initial WVelocity | Initial Acceleration

Concentrated | BodyForce | Global Distributed | Face | Local Distributed

Component Value
Concentrated load in X Dir ]
Concentrated load in % Dir -100
Concentrated load in £ Dir ]
Moment about X axis
Momert about % axis
Moment about £ axis
Moment about hinge nodes
Pore pressure

Lo R o Y o Y o Y

Datazet |Concentrated Load 1| ;I

k. I Cancel | Apply | Help

Rajah 3.11 Penetapan beban tumpu

Beban teragih seragam disetkan dengan menggunakan menu Global
Distributed. Beban akibat ralat pembinaan anggota struktur disetkan dengan
menggunakan arahan menu Attributes > Loading > Prescribed. Penetapan dibuat
dengan memasukkan nilai jarak sisihan ralat pada arah anggota yang mengalami ralat
pembinaan anggota tersebut. Rajah 3.12 menunjukkan penetapan beban akibat kesan

ralat pembinaan anggota.
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I i’
Frescribed Loading Datasets

Prescribed WVelocity I Prescribed Acceleration I
Prescribed Displacement

" Total {* Incremental

Component Displacement
Dizplacement in X Dir -5E-3
Dizplacement in % Dir ]
Dizplacement in £ Dir
Ratation about X axis
Ratation about & axis
Ratation about £ axis
Local ratation
Pare pressure

[ o Y o Y Y o Y

Dratazet |Prezcribed Load 2 j

Cloze I Cancel Apply | Help |

Rajah 3.12  Beban akibat ralat pembinaan anggota

Beban akibat enapan sokong juga menggunakan menu yang sama iaitu
Prescribed. Nilai enapan disetkan pada arah paksi-y dengan bertanda negatif (-) yang

menandakan berlaku ke arah bawah seperti mana yang dipaparkan pada Rajah.3.13



-

Frescribed Loading Datasets

Prescribed Velocity Prescribed Acceleration
Prescribed Displacement

f* Total " Incremental

Component Displacement
Displacement in X Dir 0
Displacement in % Dir -0
Displacement in £ Dir
Rotation ahout X axis
Rotation about Y axis
Rotation about £ axis
Local ratation
Pare pressure

L B o o R s [ e N o |

Datazet |Prescribed Load 1 LI

Cloze I Cancel Apply | Help |

Rajah 3.13  Penetapan beban akibat kesan enapan
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Beban akibat perubahan suhu disetkan dengan menggunakan menu Structural

> Temperature. Suhu pada akhir dan mula kajian disetkan sepertimana ditunjukkan

pada Rajah.3.14
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Structural Loading Datasets

Internal Beam Distributed

Temperature |

| Initial Velocty | Initial Acceleration
Concentrated I Bocly Force | Global Distributed | Face

Stress and Strain | Internal Beam Point

| Local Distributed

" Modal

{* Element

Component

Value

Firal temperature

Firal ¥ temperature gradient
Firal % temperature gradient
Firnal £ temperature gradient
Initial temperature

Initial ¥ temperature gradient
Initial %" temperature gradient
Initial £ temperature gradient

Lo R o Y o R o Y o R

Datazet Itemperaturﬂ

=]

ok |

Cancel | Apply

| Help

Rajah 3.14 Penetapan beban akibat perubahan suhu

Setelah segala beban telah disetkan, adalah perlu untuk menugaskan beban

yang telah disetkan pada anggota-anggota yang terlibat. Pertama sekali, pilih anggota

yang dikehendaki dan kemudian bawa ikon beban yang telah disetkan pada anggota

yang dipilih. Model-model yang telah dimodelkan ditunjukkan pada Rajah 3.15,

3.16,3.17 dan 3.18.
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Rajah 3.15 Model kekuda satah yang dibebani beban tumpu pada nod 2

Z5

11 1= 1= 10

Rajah 3.16 Model kekuda satah dibebani beban tumpu dan kesan ralat

pembinaan anggota

44
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Rajah 3.17 Model kekuda satah yang dibebani beban tumpu dan kesan

enapan pada nod 25

25

11 1z 13 L]

Rajah 3.18 Model kekuda satah yang dibebani beban tumpu dan kesan

perubahan suhu pada anggota
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3.5 Analisa LUSAS

Setelah segala penetapan telah dibuat, langkah terakhir sekali proses
menganalisa struktur. Analisis dijalankan dengan menggunakan arahan menu RUN .
Sebelum LUSAS menjalankan analisis, model tersebut perlu disimpan terlebih

dahulu. Model tersebut akan disimpan di dalam satu folder yang bernama Projects.

Bagi memperoleh keputusan atau hasil analisis, arahan menu Print Result
Wizard digunakan. Menerusi arahan menu ini, hasil analisis seperti anjakan pada
nod, daya tindak balas, putaran dan daya paksi dapat dipaparkan dalam jadual di
dalam bentuk kotak dialog. Rajah 3.19 menunjukkan kotak dialog bagi Print Result
Wizard. Rajah 3.20 pula menunjukkan jadual anjakan yang berlaku pada kekuda.

i~ i
Results Entity ﬁ]
Type I Companent j
E nitity I Dizplacement - I
Location INUdE j
< Back Finish Cancel Help

Rajah 3.19 Kotak dialog Print Result Wizard
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% LUSAS Wiew: Displacem ent Components In Global Axes Load ID = 1 Results File .. = [ G
A B C D

1 Mode D =iy RSLT

2 1 u] -0,0108 0,0108

3 2 u] -0,0131 0,03

4 3 u] -0.0114 0,0114

S 4 u] -0.0119 0,0119

=] =) u] -0,0125 0,0125

v 10 u] u] u]

= 1 u] o u]

=) 12 u] u] u]

10 13 u] u] u]

11 15 -0,0002573 -0,002356 0,002357

12 19 -0,00202 -0,0027 0,00337

13 20 -0,001 52 -0,006508 0,006525

14 25 o] 0,01 0,01

15 26 -0,00145 -0,00554 0,00596

16 27 -0,00504 -0,00454 0,00595

17 28 -0,003543 -0,0077E 00,0049

15

Rajah 3.20  Jadual anjakan pada nod

Selain itu, LUSAS boleh memaparkan gambarajah tekanan atau daya ricih

pada kekuda satah ini dengan menggunakan arahan menu View > Layer > Diagram.

Dengan cara ini, penganalisis akan mengetahui apakah yang belaku terhadap kekuda

satah ini dengan lebih jelas seperti yang ditunjukkan pada Rajah 3.21.

1/_/9725
."'28-;;
P AT
B
- 2 11 12 1= T‘l [u]
5 e
=3 =
2 pra )

Rajah 3.21 Gambarajah daya ricih
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BAB IV

ANALISIS KEKUDA SATAH

4.1 Pengenalan

Dalam kajian ini, analisis struktur yang dijalankan dibahagikan kepada dua
bahagian. Bahagian pertama adalah fasa dimana analisis dijalankan secara manual
berpandukan dan berbantukan perisian Microsoft Excel. Bahagian kedua pula, adalah
fasa berkomputer dimana analisis dijalankan dengan menggunakan perisian analisis

yang meluas dipraktikkan oleh para jurutera iaitu LUSAS.

4.2 Analisis manual

Analisis yang dijalankan melibatkan penggunaan kaedah matrik kekukuhan
dalam menganalisis struktur terhadap beban kenaan graviti seperti beban kenaan
tumpu dan beban teragih seragam dan beban fabrik. Beban fabrik yang dimaksudkan
adalah beban akibat daripada kesan perubahan suhu, kesan ralat pembinaan anggota
dan kesan enapan sokong. Struktur ini dianalisis bagi mengetahui dan mendapatkan

nilai anjakan dan daya tindak balas anggota.
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4.3 Analisis kekuda satah menggunakan kaedah matrik kekukuhan

Kekuda ini disokong rola di sambungan 1 dan 2 dan disokong pin di
sambungan 3 dan 4. Kekuda tersebut ditindaki oleh beban titik 100 kN disambungan
2. Modulus keanjalan , E dan luas keratan rentas, A untuk semua anggota masing-
masing ialah 200 kN/mm? dan 500 mm®. Analisis kekuda ini dengan menggunakan
kaedah matrik kekukuhan mengikut kes-kes yang dinyatakan di bawah:

Kes 1 : kesan beban kenaan dan kesan enapan sokong sebanyak 10 mm ke

bawah.

Kes 2 : kesan ralat pembinaan anggota pada anggota

Kes 3 : kesan perubahan suhu terhaap anggota.

8
y S }
4@%7
-
ez
100N 6 :
3
@Ec — o7

4.0m

Rajah 4.1 Kekuda satah



Penyelesaian:

Anjakan yang tidak diketahui:

50

Daya yang diketahui:

o=l

Anjakan yang diketahui: Daya yang tidak diketahui
D, 0.7
D, Q,
D
Dk=| Qu= Qs
DY Qs
D, Q,
| Ds | Qs |
Matrik kekukuhan sejagat setiap anggota:
Anggota 1
Ax =(0-0)/3=0 Ay =(3-0)/3=1
Ax2/L=0 AXAy/L=0 Ay 2/L=0.333
A’x ALy -Ax° -AxXAy
AE AXAy Ax Ay Ay
ki = e Ax? Axhy X’ AXAy
Axdy Ayt AxAy Ay’
0 0 0
k; = AE 0 0.333 0 -0.333
0 0 0
0 -0.333 0 0.333



Anggota 2

Ax = (4-0)/5 = 0.8

51

Ay = (3-0)/5 = 0.6

Ax2/L=0.8"/5=0.128 AxAy/L=08x0.6/5=0.096 Ay>/L=0.6°/5=

0.072

0.128
0.096
= AE | 0.128
-0.096

Anggota 3

Ax = (4-0)/4 = 1

0.096  -0.128 -0.096
0.072  -0.096 -0.072

-0.096 0.128 0.096
-0.072 0.096 0.072

Ax2/L=1.0%/5=025

0.25
0

ks = AE -0.25
0
Anggota 4

Ax = (4-0)/5 = 0.8

0
0
0
0

Ax2/L=08%/5=0.128

0.072
0.128
0.096
k= AE | 0128
-0.096

Ay = (3-3)/4=0

AX Ay /L=0 Ay2/L=0

-0.25 0
0 0
0.25 0
0 0

Ay = (6-3)/5=0.6

Ax Ay /L=0.8x0.6/5=0.096 Ay?/L=0.6°/5=

0.096  -0.128 -0.096
0.072  -0.096 -0.072
-0.096 0.128 0.096
-0.072 0.096 0.072
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Dengan menggabungkan matrik kekukuhan untuk setiap anggota, matriks kekukuhan

struktur, K

0.405
-0.333

K=AE | 9096

0.096
-0.096
-0.072

0

0 0.096 -0.096
0.096 0 0
0 0.378 0

0 0.128 -0.128
-0.25 -0.128 0.378

0 -0.096 0.096
0.128 0 0

4.3.1 Kesan tindakan beban kenaan dan enapan

0 0
-0.096 -0.072

0 -0.128

0 0

0 0

0 0
0.128  0.096

Terdapat enapan pada sokong nod 4 sebanyak 10mm ke bawah; maka analisis

kekuda dengan menentukan daya tindak balas sokong dan dan daya dalaman

anggota.

Penyelesaian:

Nilai anjakan ke bawah yang berlaku akibat enapan:

Dg =-0.0lm
0.405
K11 = AE
. 1
Kiy'=——
0.053AE

Anjakan yang tidak diketahui:

Du = K] 1_1 Qk

—-0.333 0.405

—-0.333
—-0.333  0.405




D] 1 0.405  —0.333] [0
D,| 0.053AE |-0333 0405 ||-100
1 [-62830
AE |764.15

D = _?628'30 — =-6.283x 107
500x10~° x200x10

D, = 7664'15 — =7.642x 10
500x10° x200x10

Jika di nod 4 berlaku enapan atau anjakan ke bawah sebanyak 10mm

Anjakan yang tidak diketahui:

0 0.405 —-0.333| | D,
=AE +
—-100 -0.333  0.405 D,

0 0.405 —-0.333| | D,
=AE
—-100 -0.333  0.405 D,
0.00
-0.072

0 0.405 —-0.333| | D, 0
=AE +
-100 —-0.333  0.405 D, 72
D, 3 1 0.405 0.333| | 0.00
D, 0.053AE [0.333 0405 |-172

1 [— 1080.679}

. ﬁ 0.072} [-oo1]

+ (500 x 10°x 200 x 10° {

} [-0.01]

AE | -1314.339
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—-0.011
= m
-0.013

Qu=ka1 Dy + koo Dx

Q, 0 0
Q, 0.096 0
—-0.096 0
| AE
Q, -0.072 0
Q, 0 —0.096
Q| 0 -0.072
0.378 0
0 0.128
+AE | 025  -0.128
0 -0.096
0.128 0
-0.096 0
SR
-106
106
= kN
79.2
28.8
121.6 |
Daya dalam anggota, q:
AE 0.8 -06 0.8
=75

= 157.719 kN

|

—-0.011
-0.013

-0.25 0
-0.128  -0.096
0.378 0.096
0.096 0.072
0 0
0 0
0.000
0.6 | | -1314339/ AE
0.000
~0.01

-0.128

0.128
0.096

-0.096

0.096
0.072

54

S O O O O

-0.01
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4.3.2 Kesan ralat pembinaan anggota pada struktur .

Anggota 3 telah dibina terpendek sebanyak Smm sebelum kekuda itu
disambungkan kepada kekuda tersebut. Analisis kekuda tersebut samada ralat
pembinaan itu, memberi kesan kepada seluruh struktur dengan membuktikan melalui
daya dalaman, daya tindak balas dan anjakan kekuda.

Penyelesaian:

Dengan menggunakan persamaan:

fo=AE (AL) /L

(Fxx)o AX
(Fay)o | =AE(AL)/L Ay
(Frx)o - AX
(FFy)O - 7Ly
Ax = (4-0)/4=1 Ay =(3-3)/4=0
Maka,
(F3)o 1
(F2)o
(Fs)o = AE (-0.05)/ 4
Fs)o
(Fo) 0
—-0.00125
0.000
=AE
0.00125

0.000



Dengan menggunakan hubungan F = KA + Fo akan menghasilkan ungkapan:

FF=0 ]
F, =-100
F3
F
¢ = AE
FS
FG
I:7
F, |
0.405 -0.333
-0.333  0.405
0
-0.096
0.096 0
-0.096 0
-0.072 0
0 -0.096
o _
0
—0.00125
0
+ AE
0.00125
0
0
_0 .

0 0.096
0.096 0
0 0.378 0

0 0.128
-0.25 -0.128

0 -0.096
0.128 0

0
Qx=K;; Du+K;; Dk + AE {Oj|

|

0
—-100

0.405
=AE
-0.333

-0.333
0.405

I

Dl
D2

}o

-0.096
0

-0.128
0.378
0.096

0

-0.25

-0.072
0

-0.096
0.096
0.072

0

0

-0.096
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0
-0.0

72

-0.128

) —_

w

~ N W

0000000

oo




Anjakan yang tidak diketahui:

Du=K;;" Q

D] 1 0.405
D,| 0.053AE |-0.333

AE

-628.30

1 |[—628.30
764.15

|

764.15

500x107°x200x10°

500x10°°x200x10°

-0333] |0
0.405 -100

=.6.283x10°m

=7642x10° m

Daya tindak balas yang tidak diketahui ditentukan melalui persamaan

Qu=Kj;; Du+ Ky Dk + AE

F, 0
F, 0.096
F, ~0.096

= AE
F, ~0.072
F, 0
F, | 0

0

S O O O

—-0.096

~0.072 ]

[—0.0125]

0.0125

|

-6.283x107°
7.642x107°

:|+O+AE
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[-0.0125 | [-125]
—0.0006 —60
AR | 6.47x107* | _ | -64.7
0.000452 45.2
—0.00073 ~-73
|-0.00055 | |-55 |

Daya dalaman anggota ditentukan dengan menggunakan persamaan

AE -AX -ly AX Ay

T

Anggota 1: Tiada ralat pembinaan

Ax=0 Ay=1
10°
= — 0 -1 0 1
qi 3
=464.167 kN

Anggota 2: Tiada ralat pembinaan.

Ax=0.8 Ay =0.6
10°
@ = —~ 08 -0.6 08 0.6

=125.66 kN

+ AE AL/L
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AE =200 kN /mm? x 500mm’ =1 x 10°

D, =0
D, =—6.283x10"
D, =0

| D, =7.642x107° |

AE =200 kN /mm” x 500mm’ =1 x 10°

D, =0
D, =—6.283x107°
D, =0
D, =0



59

Anggota 3: Pada anggota 3 berlaku ralat pembinaan.

Ax =1 Ay =0 AE =200 kN /mm” x 500mm’ = 1 x 10’
D, =0
5 D, =7.642x107°
QG = 107, 0 1 0 2 - (10° x 0.005 / 4)
5 D, =0
D, =0
=-125kN

Anggota 4: Tiada ralat pembinaan belaku.

Ax =0.8 Ay =0.6 AE =200 kN /mm” x 500mm* =1 x 10°
D, =0
5 _ -3
w=" 108 06 08 06 D, =7.642x107
5 D, =0
D, =0
=-91.70 kN

4.3.3 Kesan perubahan suhu terhadap anggota struktur.

Anggota 1 mengalami pertambahan suhu sebanyak 20°C dengan kadar suhu iaitu

1.5x 107 °C. Nilai AE ialah 1 x 10°

Penyelesaian:

Dengan menggunakan persamaan:

fo=AE a (AT)



(Fxx)o AX
(FNy)O Ky
(FFx)O . - }\,X
(Fey)o = AE a (AT) Ay
Maka,
(E4)o 0
(F1)o s -1
(F3)o = AE (1.5x10™) (20)
0
(Fz)O
-1
0
3x107*
=AE
0
-3x107*

Dengan menggunakan hubungan F = KA + Fo akan menghasilkan ungkapan:
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o —_

(%)

(=)} W

~

nn . o om o m o m m T

o0

Qk:KllDu+K12Dk+AE|:

~0.3337 [D,
+0+AE
0.405 || D,

~0.333] [ D,
~0.333 0.405 ||D,

0 0.405
=AE
—-100 -0.333

~30
= AE

{0.405

-0
=-100
— AE
0.405 -0.333 0 0.096
20333 0.405  0.096 0
0 0 0.378
-0.096
0.096 0 0 0.128
-0.096 0 025 -0.128
-0.072 0 0 -0.096
0 -0.096  0.128 0
D, ] [3x107*
D, —3x107*
D, 0
D
‘| 4 AE 0
D, 0
D, 0
D, 0
_DS_ _0 _

3x107*
—3x107*

0

-0.096
0

-0.128
0.378
0.096

0

-0.072

-0.25

-0.096
0.096
0.072

3x107*
—3x107*

0

|

0

0

-0.096
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0
-0.0

72

-0.128




Anjakan yang tidak diketahui:

Du=K;;" Q
D, B 1 0.405 -0.333| | —-30
D, 0.053AE |-—-0.333 0.405 -70
1 [-669.057
AE | —723.396

D, —6.69x107°
= m
D, —7.23x107°

Daya tindak balas yang tidak diketahui ditentukan melalui persamaan

Qu:K21 Du + Ky Dk + AE

S O O O O O




F, 0 0
F, 0.096 0
F, -0.096 0 —6.69x107
= AE +0+0
Fe -0.072 0 —7.23x107
F, 0 —0.096
F | K —0.072
o0 1 0 -
—-6.42x107° —64.2
6.42x107° 64.2
= AE = kN
4.82x10°° 48.22
6.94x107° 69.4
521x10”° | 521

Daya dalaman anggota ditentukan dengan menggunakan persamaan

AE -Ax -Ay  AX Ay

D

q=— D + AE o (AT)
L D

D

Anggota 1: Berlaku perubahan suhu pada anggota 1 sebanyak 20°C
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Ax =0 Ay =1 AE =200 kN /mm” x 500mm” =1 x 10°
D, —0 B}
5 D, =—6.69x10~*
q = 107 | 0 -1 0 1 : -10° x (1.5x107)
3 D, =0
D, =-7.23x10"" |

(20)
=-31.8 kN
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Anggota 2: Tiada perubahan suhu berlaku pada anggota 2.

Ax=0.8 Ay =0.6 AE =200 kN /mm” x 500mm” = 1 x 10°
D, =0
s D, =—6.69x10"*
w=-2 |08 -06 08 og| |DTEOT
5 D, =0
D, =0
=8.028 kN

Anggota 3: Tiada perubahan suhu berlaku.

Ax =1 Ay =0 AE =200 kN /mm” x 500mm’ = 1 x 10
D,=0
s D, =-7.23x10~*
=2 14 o 1 o0 2 =772310H
5 D, =0
D, =0
=0kN
Anggota 4: Tiada berlaku perubahan suhu
Ax =0.8 Ay =0.6 AE =200 kN /mm” x 500mm’ = 1 x 10’
D, =0
> D, =-7.23x10°
Q= 07 |08 06 08 06 N
5 D, =0
D, =0

=-8.676 kN



4.4 Analisis kekuda menggunakan perisian LUSAS
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Berdasarkan analisis yang dijalankan melalui kaedah perisian LUSAS, didapati nilai

anjakan yang diperoleh adalah sama seperti yang dikira melalui kaedah matrik kekukuhan. Rajah

4.2 menunjukkan jadual yang dihasilkan oleh LUSAS yang menyimpulkan segala anjakan yang

berlaku pada setiap nod pada kekuda satah ini akibat kesan enapan.

Eé LUSAS View: Displacement Compeonents In Global Axes Load ID =

=R X

1 Results File...

B C D
1 MNode DX oY RELT
7 1 a 00108 0,0108
3 2 0 0,013 0,013
4 3 0 00114 00114
5 4 0 0,013 00114
6 5 0 00125 00125
7 10 a a a

& 1 i i i

g 12 0 0 0

1m |13 0 0 0
T -0,000253 -0,00236 0,00237
1z |13 -0,00202 00027 0,00337
13 |20 -0,00152 -0,00606 0,00625
14 |25 0 -0, 0,m

15 |26 -0,00145 -0,00554 0,00896
16 |27 -0,00504 -0,00454 0,00695
17 |28 000343 000776 0,00549
18

Rajah 4.2 Anjakan pada nod bagi kes enapan sokong

Daya ricih bagi kekuda satah yang dihasilkan oleh LUSAS boleh dirujuk pada Rajah

43.

% LUISAS Wiew: Eeaction Com ponents In Global Axes Lo

A

C

Ly | Y )

Mode

1
2

10
25

Fr
03
29,5
103
295

v
0
0
TrE
224

RSLT
103
295
129
373

Rajah 4.3 Daya ricih akibat kesan enapan
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Rajah 4.4 menunjukkan anjakan yang berlaku pada nod akibat kesan ralat pembinaan

pada anggota 3 kekuda satah ini.

br

% LUSAS Wiew: Displacem ent Com ponent... =R
A B C | D |
1 Mode [ Oy RSLT
2 1 1] -0,00592 000692
3 2 0,005 -0,00837 000353
4 3 0 -0,00893 0,00633
= 4 0 -0,00894 0,00694
5 =) u] -0,00696 0,00696
7 10 0,005 0 0,005
g 11 -0,005 0 0,003
9 12 -0,005 0 0,005
10 13 -0,005 0 0,005
11 18 -0,00147 -0,00477F 0,00499
12 19 -0,0035 -0,00212 0,0041
13 20 -0,00215 -0,003949 0,00453
14 23 0 0 0
13 26 -0,000329 -0,002a7 0,00299
16 o -0,00264 -0,00331 0,00425
17 28 -0,001:51 -0,00522 0,005356
18
E T ¢
L
Rajah 4.4  Anjakan pada nod akibat ralat pembinaan

Rajah 4.5 menunjukkan anjakan yang berlaku pada nod akibat kesan perubahan suhu

pada kekuda satah.

% LUSAS Wiew: Displacement Com ponent.. | =[] i:hl
A B C D |

1 Mode Lo O RSLT
2 1 u] -0,00667 0,00657
3 2 u] -0,00722 000722
4 3 u] -0,00551 0,00651
=] 4 u] -0,00594 0,00694
5 3 u} -0,00705 000705
E 10 u] u] u]
g 11 u} u} u}
=] 12 u] u] u]
10 13 u] u] u]
11 15 -0,0001 35 -0,001 4G 0,001 47
12 149 -0,00125 -0,001 67 0,00209
13 20 -0,000935 -0,00375 000357
14 25 u] u] u]
15 26 -0,000169 -0,00158 0,001:59
16 27 -0,00135 -0,0015 000225
17 28 -0,00101 -0,00406 0,00415
18

Rajah 4.5 Anjakan pada nod akibat kesan perubahan suhu
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Rajah 4.6 menunjukkan daya tindak balas yang berlaku pada nod akibat kesan
perubahan suhu pada kekuda satah.

Bﬁ LUSAS View: Reaction Compaonents In Glab.. I.'Z' (=] &J

A B C | D |
1 Node F¥ Fy RSLT
2|1 641 0 B4 1
3|2 69,3 0 £33
4 |10 B4 1 481 20,1
5 |25 £33 514 865
B

Rajah 4.6 Daya tindak balas pada nod akibat kesan perubahan suhu

Model-model kekuda satah yang telah dibuat di dalam LUSAS telah ditunjukkan dan
boleh dirujuk pada Rajah 3.15, Rajah 3.16 dan Rajah 3.17.
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BAB YV

ANALISIS KERANGKA SATAH

5.1 Pengenalan

Dalam kajian ini, analisis struktur yang dijalankan dibahagikan kepada dua
bahagian. Bahagian pertama adalah fasa dimana analisis dijalankan dengan
menggunakan kaedah matrik kekukuhan berpandukan dan berbantukan perisian
Microsoft Excel. Bahagian kedua pula, adalah fasa berkomputer dimana analisis
dijalankan dengan menggunakan perisian analisis yang meluas dipraktikkan oleh

para jurutera iaitu LUSAS.

5.2 Analisis kerangka satah menggunakan kaedah matrik kekukuhan

5.2.1 Kesan Tindakan Enapan

Kerangka satah seperti mana yang ditunjukkan pada Rajah 5.1 terdiri
daripada 2 anggota. Diberi nilai luas keratan rentas anggota, A ialah 4 x 10-3 m”
manakala nilai modulus keanjalan, E dan nilai momen sifat tekunnya, I ialah 200 x

100° Kn/m* dan 100 x 10°®m®. Struktur ini mengalami enapan pada sokong 2



sebanyak 40mm. Analisis kerangka satah ini dengan menggunakan kaedah

kekukuhan dan dibuktikan dengan peyelesaian peisian LUSAS.

o] =ml B

Rajah 5.1 Kerangka satah

8
9%7
©)

Rajah 5.2 Sistem pernomboran dan darjah kebebasan kerangka

Penyelesaian:
Daya yang diketahui:
Q 0
Qk=1Q, =10
Q; 0

69



Anjakan yang diketahui:
D, o :
D, 0
D, 0
Dk = =
D, 0
D, -0.04
L D9 _ _0 .

Matriks kekukuhan struktur:

Unsur-unsur dalam matrik kekukuhan anggota, k:

Anggota l: L =6.0m
e AE/L=133.333x 10° kN/m
e I2E/L’=1.111x 10’ kN/m
e GEI/L*=3.333x10°kN
e 4EI/L =13.333 x10° kNm
e 2EI/L=6.667 x 10’ kNm

Matrik kekukuhan anggota 1, k;:

4 5 6 1 2
133.333 0 0 -13.333 0
0 1.111 3.333 0 -1.111
K, = 0 3.333 13.333 0 -3.333
-133.333 0 0 133.333 0
0 -1.111 -3.333 0 1.111
0 3.333 6.667 0 -3.333
Anggota2: L =4.0m

AE/L =200 x 10° kKN/m
12EI/L? = 3.75 x 10° kN/m
6EI/L*=7.5x 10° kN

3.333
6.667

-3.333
13.333

W N = W O\ W
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e 4EI/L =20 x10° kNm
e 2EI/L=10x 10°kNm

Matrik kekukuhan anggota 2, k:

1 2 3 7
3.75 0 7.5 -3.75
0 200 0 0
K, = 7.5 0 20 -7.5
-3.75 0 -7.5 3.75
0 -200 0 0
7.5 0 10 -7.5

-200

0
200
0

7.5

10
-7.5
0
20

O 00 J W N —
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Matrik kekukuhan struktur diperoleh dengan menggabungkan kedua-dua

matrik kekukuhan sejagat setiap anggota ke dalam satu matrik kekukuhan global, K

dan seterusnya dengan menggunakan hubungan daya dan anjakan iaitu F = K D,

maka terbentuklah persaman matrik:

[0 ] | 137.08 0 75 -133.33
0 0 201.1 -3.33 0
0 7.5 333 3333 0
213333 0 0 133.33
Fol_| o -L.111 333 0
F, 0 333 6.67 0
. 3.75 0 7.5 0
6
0 200 0 0
F, 7.5 0 10 0
_FS_
SR
D2
D3
0
x10° x [0
0
0
~0.04
_O -

-1.111
3.33
0
1.11
3.33

0

0 -3.75
-3.33 0
6.67 -7.5
0 0
3.33 0
13.33 0
0 3.75
0 0
0 -7.5

-200

0

2

0
0
0

0
0

0
00
0

7.5

10

-7.5

20




Anjakan yang terhasil:
Fkl_ k11 k2| |Au
Fu K21 K22 Ak

Fk=K;; Au + K;» Ak

| 137.08 0 75
0= 0 201.1 -3.33
0 75 333 33.33

213333 0
+EI 0 -1.111
0 3.33
D1 —2.2x107*
D2 | =3.98x10"* | rad
D3 0.004

Daya tindak balas pada sokong:
Fu= K21 Au + K22 Ak + FR

F4 13333 0
F5 0 1111
F6 | _ 13| © 3.33
F7 -3.75 0
F8 0 200
F9 75 0

13333 0

0 1.11

+10° | ¢ 3.33

0 0

0 0

0 0

D1
D2
D3
0 375 0 75
333 0 2200 0
667  -15 0 10
0
3.33 —2.2x10™
6.67 3.98x10~
75
0 0.004
10
0 0 0 0
3.33 0 0 0
1333 0 0 0
0 375 0 75
0 0 200 0
0 75 0 20

S O O O

—-0.04

oS O O O

—-0.04
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[29.332 ]
-30.9
—-105.85
-29.18
15.96

38.35

Daya hujung anggota:

Dengan menggunakan formula asas iaitu f =kTD,

133.333 0 0 -13.333 0 0
0 1.111 3.333 0 -1.111 3333
£ o 0 3.333 13.333 0 3333 6.667 < [r]
! -133.333 0 0 133333 0 0
0 -1.111 -3.333 0 1.111  -3.333
0 3.333 6.667 0 -3.333  13.333
o }
0
0
X
—0.00022
0.0398
10.004 |
F, | [29.3326]
F, 2.442
Fo|  [-5.954
F, 29.3
F, 2.442
F,| 20686

5.2.2 Kesan ralat pembinaan

Pada anggota 1, berlaku ralat pembinaan iaitu dimana anggota 1 dibina atau
dipasang terpendek sebanyak 0.1m. Analisis kerangka satah ini berdasarkan Rajah
5.3.
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Dengan menggunakan persamaan:

fo=AE (AL)/L

(Fxx)o AX
(Fxy)o | =AE(AL)/L Ly
(Fxz)0 Az
(Frx)0 - AX
(Fry)o - Ay
(Frz)o -z
Ax = (6-0)/6 = 1 Ay=0
Maka,
(F4)0 _1 |
(Fs)o 0
(Fe)o
(F1)o =EI(-0.1)/6
(Fz)O —1
(F3)0
[—0.0167 |
0
0
=FEI
0.0167
0
_O .|
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Dengan menggunakan hubungan daya dan anjakan, f=kD:

0 ] 137.08
0 0
7.5
0 -133.33
F 0
¢ :103 0
FS
-3.75
F, 0
F, 7.5
_F8_
D1
D2
D3
0
x|0 | +10°
0
0
0
_0 -
Anjakan yang terhasil:
Fkl_ k11 k12
Fu K21 K22

0 7.5
201.1 -3.33
3.33  33.33
0 0
1111 3.33
333 6.67
0 7.5
-200 0
0 10

[0.0167 ]

0

0

-0.0167

0

0

0

0

_O -

]

Fk = Kj; Au + K5 Ak +Fr

137.08 0 75

01=1 o 201.1 -3.33

0 75 333 33.33
213333 0 0
+EI 0  -1.111 -3.33
0 333 6.67

-133.33 0
0 -1.111
0 3.33

133.33 0
0 1.11
0 3.33
0 0
0 0
0 0

-3.75 0
-200
-7.5 0

0
-3.33
6.67
0
3.33
13.33
0
0
0

7.5

S O O O O O

75

7.5

10

-7.5

20




0.0167
+EI|O

D1 0.1233

D2|=|-4.607x10"" | rad

D3 —-0.02779

Daya hujung anggota:

Dengan menggunakan formula asas iaitu f = kTD,

133.333 0
0 1.111
0 3.333

-133.333 0
0 -1.111
0 3.333

f1:

0

0

0

0.1233
—4.607x107*
| —0.02779

[16.4396 |
—0.09203
—0.1838
16.4396
0.0921

| —0.36891 |

w -J:n

[

[SS]

m M T T T

(%)

0

3.333
13.333

0

-3.333

6.667

-13.333

0
0

133.333

0
0

-1.111
-3.333

1.111
-3.333

3.333
6.667

-3.333
13.333
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5.2.3 Kesan perubahan suhu pada kekuda satah

Pada anggota 1, berlaku perubahan suhu iaitu dimana anggota 1 mengalami

kenaikan suhu sebanyak 20°C. Analisis kerangka satah ini.

Dengan menggunakan persamaan:

fo=El a (AT)
(Fxx)0 AX
(Fxy)o | =EIL o (AT) Ly
(Fxnz)o AZ
(Frx)o - AX
(Fry)o - Ay
(Frz)o - A7
Ax = (6-0)/6 = 1 Ay =0
Maka,
(Fa)o 1]
(Fs)o
(Fe)o
(F1)o =EI(1.2x10°)x 20
(Fz)O -1
(F3)o
[2.4x107*
0
0
= EI
—2.4x107*
0
_0 -




Dengan menggunakan hubungan daya dan anjakan, f=kD:

0 137.08 0 7.5 213333 0
0 0 201.1 -3.33 0 -1.111
0 7.5 3.33  33.33 0 3.33
e -133.33 0 0 133.33 0
‘=103 0 -1.111 3.33 0 1.11
Fs 0 333 6.67 0 3.33
F, -3.75 0 7.5 0 0
. 0 2200 0 0 0
7 7.5 0 10 0 0
_F8_
DI —2.4x107*
D2 0
D3 0
0 2.4x107*
x [0 | +10° |0
0 0
0 0
0 0
0 | 0
Anjakan yang terhasil:
Fk| _ | k11 K12 Au
Fu K21 K22 Ak
Fk = K]] Au + K]z Ak +FR
DI
| 137.08 0 7.5
01=1 o 201.1 -3.33 D2
0 7.5 3.33  33.33 D3
-13333 0 -3.75 0
4RI 0 1111 -3.33 0 -200
0 3.33 6.67 7.5 0

0
-3.33
6.67
0
3.33
13.33
0
0
0

7.5

10
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7.5

10

-7.5
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-2.4x107*
+10

D1 —1.7726x107
D2 | =16.6209x10° | rad
D3 3.9951x107*

Daya hujung anggota:

Dengan menggunakan formula asas iaitu f = kTD,

133.333 0 0 -13.333 0
0 1.111 3.333 0 -1.111
£ - 0 3.333 13.333 0 -3.333
! -133.333 0 0 133333 0
0 -1.111 -3.333 0 1.111
0 3.333 6.667 0 -3.333
0 B}
0
0
* | Z1.7726x10°
6.6209x10°°
13.9951x107* |
'F, ] [0.000236
F, 0.001323
Fo|  |0.00264 e
F, —0.000236
F, —0.00132
F, | 10.00530 |

3.333
6.667

-3.333
13.333
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5.3 Hasil analisis LUSAS
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Rajah 5.3 menunjukkan anjakan pada nod akibat daripada enapan pada sokong 2.

% LUSAS Wiew: Displacem ent Com ponents In Glokal Ace =[S e S
A B = D E |
rlocie o Oy THE RSLT
1 u} u} u} u}
e 0,00022 -0,0395 -0,00404 0,0395
3 5 51e-005 -0,00509 -0,00521 0,00509
4 0,001 -0,0189 -0,00595 0,0189
5 0,0001 65 -0,0302 -0,00522 0,0302
10 a -0,04 a 0,04
11 -0,00205 -0,0399 -0,000522 0,0399
12 -0,001 91 -0,0399 0,000921 0,04
13 -0,000723 -0,04 0,0012 0,04

Rajah 5.3 Anjakan pada nod akibat kesan enapan

Rajah 5.4 menunjukkan daya tindak balas yang terhasil akibat kesan enapan

% LLISAS Wiew: Reaction Compaonents In Glokbal Axes Lo |.':' E] ﬁ]
A B C D | E
1 Mode Fx F ML RSLT
2 1 -29.4 30,8 106 42 5
3 10 29,4 -30, 36 5 42 5
4
" 1 r
|-

Rajah 5.4 Daya tindak balas pada sokong akibat kesan enapan
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Rajah 5.5 menunjukkan anjakan pada nod akibat kesan ralat pembinaan anggota kerangka satah

% LLISAS View: Displacem ent Com ponents In Global & |.':' (=] &J
A B [ D | E
1 Mode D DY THZ RELT
2 1 031 ] ] 0,1
3 2 -D0gss 0,000367 00222 0,0955
] 3 -D,0995 -0,00E19 -0,00835 0,0993
5 4 -D,0992 J001ES -0,00544 0,104
B 5 0,095 00184 D0,00424 0,104
7 10 0 u] u] 0
B 11 -D,0706 0,000276 0,038 0,0706
g 12 00382 0,0001 54 0,034 0,0382
1o |13 ooz 9.18e-005 00207 00112
11
o L [
[ A

Rajah 5.5 Anjakan pada nod akibat kesan ralat pembinaan anggota

Rajah 5.6 menunjukkan anjakan pada nod akibat kesan perubahan suhu pada anggota

kerangka satah.

% LUSAS Wiew: Displacem ent Com ponents In Global Scc I. = | =1 i:hl
A B c D | E

1 hode [ [ THE RSLT

2 1 o u} o u}

3 2 0,00142 0,000114 -0,000307 0,001 42

4 3 0,000354 00,0001 04 o,.000117 0,000:569

= 4 Q,000709 0,000285 0,0001 0= 0,00075S

=] ] 0,001 05 0,0003355 -3 65e-0035 o,00112

7 10 a u} a u}

= 11 a,0010:2 -4 .31 e-006 -0,0004:56 0,001 02

a 12 0,000:555 -2,88e-006 -0,0004:54 0,000:5:55

10 13 0,000154 -1, 44=-006 -0,000302 00,0001 54

11

« I 3

Rajah 5.6 Anjakan pada nod akibat kesan perubahan suhu
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Rajah 5.7 menunjukkan daya tindak balas pada nod akibat kesan perubahan suhu

pada anggota kerangka satah.

E@ LUISAS YView: Reaction Com |m|'|ents In Glclk-ﬁxes Loa... E@ﬁ
A | e |
1 Mode Fi RELT
2 1 3,01 1 ,1 g 2,43 322
3 10 5,01 1,15 7,55 322
4
L
Rajah 5.7 Daya tindak balas pada nod akibat kesan perubahan suhu

Model-model struktur kerangka satah yang dimodelkan di dalam perisian LUSAS

adalah seperti yang ditunjukkan pada Rajah 5.8, Rajah 5.9 dan Rajah 5.10.

% LUSAS View: psm-frame-enapan.mdl Window 1

—-

3. ...

Rajah 5.8 Model kerangka satah

yang berlaku kesan enapan



% LUSAS View: psm-frame-misbuilt3 mdl Windeow 1 E@ﬁ
ol oL 0. T 2o CA Fo S ... 7]
= 3 o ] 2

- 11

- 12

o 12

T = A

o

Rajah 5.9 Model kerangka satah yang berlaku kesan ralat pembinaan

anggota
F
% LUSAS Yiew: psm-fram e-tem pomdl Windcw 1 [ = | = ﬁ
vl e - . : ’ - £ .
o ot 2 <} 4] 2
) 11
(o] 1=
1=
: ey
L=

Rajah 5.10 Model kerangka satah yang berlaku kesan perubahan suhu
anggota
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BAB VI

ANALISIS RASUK

6.1 Pengenalan

Dalam kajian ini, analisis struktur terhadap rasuk yang dijalankan
dibahagikan kepada tiga bahagian. Bahagian pertama adalah fasa dimana analisis
dijalankan dengan menggunakan kaedah matrik kekukuhan berpandukan dan
berbantukan perisian Microsoft Excel. Bahagian kedua pula, adalah fasa
berkomputer dimana analisis dijalankan dengan menggunakan perisian analisis yang

meluas dipraktikkan oleh para jurutera iaitu LUSAS.

6.2 Analisis rasuk menggunakan kaedah matrik kekukuhan

ol 0k ¢ 20

Rajah 6.1 Rasuk
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T
™ "4 : @éjl : k&i@

Rajah 6.2 Darjah kebebasan bagi rasuk

Rajah di atas menunjukkan sabatang rasuk yang diikat tegar di sambungan 1 dan 3
dan disokong rola pada sambungan 2. Rasuk ini mempunyai nilai nisbah E sebanyak
200x10° kN/m dan nilai I sebanyak 216x10° m *
Analisis rasuk ini terhadap tiga jenis beban iaitu:

e Beban akibat kesan enapan sokong.

e Beban akibat kesan ralat pembinaan anggota.

e Beban akibat kesan perubahan suhu.

Penyelesaian :

Daya dan anjakan yang tidak diketahui:

Du=[D,] Qk=1[Q ] = [0] kN
'D,] [-0.05] Q, |
D3 O Q3
Dk=|D,|= |0 Qu=|Q,
DS 0 QS
D] [0 | Q|




Matrik kekukuhan anggota struktur, k:

Anggota 1:

Kl

12EI/L?
6EI/L?
-12E1/L?

6EI/L?
AFT1/T 3

0.023
0.094
-0.023
-0.094

Anggota 2:

K2

12EI/L?
6E1/L?
-12E1/L}

6E1/L?
ART/T 3

2

0.096

0.24
-0.096
-0.094

6EI/L?
4EI/L
-6EI/L?
2EI/L

0.094

0.5
-0.094

0.25

6EI/L?
4EI/L
-6EI/L?
2EI/L

0.24
0.8
-0.24
0.4

12EI/L®  6EI/L’

6EI/L>  2EI/L°

12EI/L°>  -6EI/L®
-6EI/L’

2 1
-0.023 0.094
-0.094 0.25

0.023 -0.094
-0.094 0.5
12EI/L>  6EI/L?
6EI/L>  2EI/L°
12E/L>  -6EI/L}

-6EI/L’

5 6
-0.096 0.24
-0.24 0.4

0.096  -0.24
-0.24 0.8

— N AW

AN L — N
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F3
F4
F5
Fé6

Hubungan matrik kekukuhan struktur global dengan daya dan anjakan:

F=KD
1
1.3
0.146
=EI 0.094
0.25
-0.24
0.4

2 3 4 5
0.146 0.094 025 -0.24
0.119  -0.023 -0.094 0.096

-0.023 0.023 0.094 0

-0.094 0.094 0.5 0
0.096 0 0 0.096
0.24 0 0 -0.24

6.2.1 Beban akibat kesan enapan sokong.

Anjakan yang tidak diketahui

)

K11
K21

Fk =K;j; Au + K;» Ak

[0] =EI [1.3] [D1] + EI

[D1] = [5.6154x107* | rad

Daya tindak balas:

Fu =K, Au + Ky Ak

K12 Au
K22 Ak

‘0.146 0.094 0.25 -0.24

6

0.4
0.24

(e}

-0.24
0.8

0.4

[—0.05]

S O O

-0.05

SO OO
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F2
F3
F4
F5
Fo6

F2
F3
F4
F5
Fé6

= EI

+ EI

=EI

0.146
0.094
0.25
-0.24
0.4

0.119
-0.023
-0.094
0.096
0.24

[—0.00562 ]
0.001362
0.005267
0.00426

|—0.0111 |

|5.6154x107 |

-0.023 -0.094
0.023  0.094
0.094 0.5

0 0
0 0

[242.784 ]
58.8384
227.5344
148.032

|—419.52 |

Daya ricih dan momen hujung anggota

0.096 0.24 -0.05
0 0 0
0 0 0
0.096 -0.24 0
-0.24 0.8 0
kN
0.094 0
0.25 0
-0.094 —-0.05
0.5 _5.6154x10‘3

Anggota 1
E 0.023  0.094  -0.023
Fol gl 0094 05 -0.094
F, -0.023  -0.094  0.023
e -0.094 025  -0.094
1
72.49
26352
| -72.49

324.43
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Anggota 2
F, 0.096 024  -0.096
F| | o024 0.8 -0.24
£ | ~El 0096 024 0.096
> -0.094 0.4 -0.24
F6
—26.784
| -8208
a 26.784
—142.56

6.2.2 Beban akibat kesan ralat pembinaan anggota

0.24
0.4

-0.24
0.8

10 kN

&9

—0.05
5.6154x107°
0

0

6.0

Rajah 6.3 Rasuk kes 2

2.0

2.0
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10 &N

Rajah 6.5 Darjah kebebasan bagi rasuk kes 2

10 kN

Rajah 6.6 Daya paksi dan momen hujung terikat

Analisis rasuk ini jika mengalami ralat pembinaan iaitu berlaku ralat sebanyak 0.1m

pada anggota 2.

Daya dan anjakan yang tidak diketahui:



[%)

Dk

w

I
OO DD
S O O O

Matrik kekukuhan sejagat anggota struktur, k:

Anggota 1:
AFE/L 0
0 4EI/L
K= | -AE/L 0
0 2EI/L
5 6
6.667x10° 0
0 28800
K. = -6.667x10° 0
=
0 14400
Anggota 2:
3 1
10° 0.
0 43200
6
K,—| 10 0
0 21600

Hubungan matrik kekukuhan struktur global dengan daya dan anjakan:

F =KD + Fr

-AE/L 0
0 2EI/L
AE/L 0
0 4EI/L
3 1
-6.667x10° 0
0 14400
6.667x10° 0
0 28800
4 2
-10° 0
0 21600
10° 0
0 43200

— W O\ W

oA = W



-5
F3
F4
F5
Fé6

FAX //LX
FAZ Az
Fr= =EI AL/L
Fax — AX
Fe, - Az |
1] [25x10°
6 0 0
=10"x(0.10/4) =
-1 —-25x10°
0 0
1 2 3 4 5
72000 21600 0 0 0
21600 43200 0 0 0
0 0 1.667x106 -106 -6.667x105
0 0 -106 106 0
0 0 -6.667x105 0 6.667x105
14400 0 0 0 0
0 1
+ 0 2
25x10° | 3
-25x10°| 4
0 5
0 6
Anjakan yang tidak diketahui
Fk _ K1 K AU
Ful Ky Kp Ak
Fk =Kj; Au + K5 Ak
714 72000 21600 | |BL}_ o1y 0 0
5 21600 43200 D2 0 0 0

6
14400

0

0

0

0
28800

14400

D,

oS O O

S O O O
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0
_|_
D1 1.23x10™
= rad
D2 —1.8x107*
Daya tindak balas:

Fu=K21 Au + Kzz Ak+FR

F3 0 0 25x10°
F4 0 0 1.23x107 -25x10°
Fs |“EL| o 0 L] T "
—1.8x10
F6 14400 0 0
25000
| =25000
0
17712
Daya ricih dan daya dalaman anggota
Anggota 1:
F5 6.667x10° 0 -6.667x10° 0 0 0
F6| 0 28800 0 14400 | |0 0
F3| T l6.667x10° 0 6.667x10° 0 0 * 1 55x103
0 14400 0 28800 y
F1 1.23x10 0
63.00066
1615057
| =34.0007

142.739



Anggota 2

0
F3 10° 0. -10° 0

FLT_ g |0 43200 0 21600 1.23x10™
F4 10° 0 10° 0 0

Fo 0 21600 0 43200 | | g0

25x10°

—25x10°

—-99.3155
249.677
133.3155

—213.857

6.2.3 Beban akibat kesan perubahan suhu

Analisis struktur yang mengalami perubahan suhu pada anggota 2 sebanyak 200C

dengan kadar suhu, a sebanyak 1.2x10°°C"!
Hubungan matrik kekukuhan struktur global dengan daya dan anjakan:
F=KD + F;

Fi=El a A

1 240

F
F
A 1=10°%x12x10°x20 =
Foy -1 ~240
F




-5
F3
F4
F5
F6

1 2 3 4 5 6
72000 21600 0 0 0 14400
21600 43200 0 0 0 0
= 0 0 1.667x106 -106 -6.667x105 0
0 0 -106 106 0 0
0 0 -6.667x105 0 6.667x105 0
14400 0 0 0 0 28800
0 1
0 2
+ 240 3
-240 4
0 5
0 6
Anjakan yang tidak diketahui
Fk| K11 Ki2 Au LF
Ful K21 K22 Ak !
5
_ | 72000 21600 DL o4 |0
-5 21600 72000 D2 0
0.0001225
= T
—0.000177015
Daya yang tidak diketahui. Qk
Fu=K5; Au+ Ky, Ak + F;
F3 0 0
240
F4 | _ Bl 0 0 0.0001225 | 240
F5 0 0 —0.000177015 0
F6 14400 0

0

D,

oS O O
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240
—-250

1.764

Daya ricih dan daya dalaman anggota:

Anggota 1:
F5 6.667x10° 0
F6| 0 28800
F3| = E 6.6067x105 14200
F1
0
[ 1764
1240
3.528
Anggota 2
Ei’ 10° 0.
0 43200
=EI
F4 10° 0
F2 0 21600
0
[ 1.468
10

-6.667x10°
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0 0
0 0

+
0 250
1.23x107* 0
0 250
1.23x10°* 0

+
0 —250
1.8x107* 0



6.3 Hasil analisis LUSAS

Rajah 6.6 dan Rajah 6.7 menunjukkan anjakan pada nod dan daya yang terhasil
akibat kesan enapan hasil daripada analisis LUSAS.

Eﬁ LUSAS View: Displacem ent Components In Global L l. = | = &J

A B C D | E
1 Mode O o THZ RELT
2 1 0 0 0 0
5 z il 00s 0 00561 oo
4 5 il 0 AnEEs 20 O0ETS L
5 4 0 00306 opios 00306
& 5 0 0 04a5 000597 00485
T 10 il o o o
5 14 0 ‘n0nzaz 00123 00382
a 12 0 oo0z1s 00136 00215
0 |43 il 200085 0 0094 0 006s
11

Rajah 6.6 Anjakan pada nod akibat kesan enapan

% LUSAS View: &veraged Forces And IMam ents . l =NNEN X
A B c | D |

1 Mode Fx Fy Mz

2 1 ] -r33 263

3 2 ] 37 g =324

4 & ] -r33 116

5 4 0 733 303

G ] ] -r33 17T

v 10 ] 143 4

i 1 ] 143 -13d

3 12 ] 143 45,5

10 13 ] 143 233

11

Rajah 6.7 Daya pada nod akibat kesan enapan




Rajah 6.8 menunjukkan anjakan pada nod akibat kesan ralat pembinaan hasil

daripada analisis LUSAS.

% LISAS Wiew: Displacem ent Com ponents In Global Lo = | S| S
A B C D | E
1 Mo DX o THZ RSLT
2 1 o o ] ]
3 2 0,06 o -0,0001 23 0,06
4 3 0015 3,45e-005 3,52e-005 0015
5 a4 0,03 9,19e-005 3,05e-005 0,03
3 5 0,045 0,0001 03 J2,3 e00s 0,045
7 10 0,08 0,0002258 1.35e.005 0,05
8 11 0,065 B 9e_005 0,0001 45 0,065
g 12 0,07 -0,0001 44 -0,0001 36 0,07
0 |13 0,075 -0,0002 9,18e-005 0,075
11 18 0,1 ] 0,0001 77 01
12 |19 0,055 -0,000213 £,99e-005 0,055
13 |20 0,09 -0,000162 0,00013 0,09
14 |2 0,095 8 BBe-005 0,000165 0,095
15
- 1ir 3
Rajah 6.8 Anjakan pada nod akibat kesan ralat pembinaan anggota

Rajah 6.9 menunjukkan anjakan pada nod akibat kesan ralat pembinaan hasil

daripada analisis LUSAS.

% LLISAS Wiew: Displacem ent Com ponents i Glabal A |. = | [=] i:h.l
A B c D | E

1 rHode [k L THZ RSLT

2 1 u) u) u] u]

3 2 o,00018 u) -0,0001 23 0.0001s

4 3 2,7 e-020 3,45=-005 3,582e-005 3, 45=-005

=] 4 5, 42e-020 9,19e-005 3 05e-005 9,19=-005

=] =] 9,49e-020 0000103 -2, 31e-003 0,0001 03

v 10 000065 -0,0002225 -1, 352-003 0,000593

[=] 11 0,0003 -5, 9e-005 -0,0001 45 0,000305

=] 12 0,00042 -0,0001 41 -0,0001 36 0,000443

10 13 0,000:5:4 -0,0002 -9,158=-003 0,000576

11 = 0,00114 o o.000177 o,00114

12 19 0,00075 -0,000213 5 99e-005 0,0005059

13 20 0,0003 -0,0001 82 0,000 3 0,00091 4

14 21 o,00102 -3,68e-005 0,000 635 0,00102

15

] 1 r

Rajah 6.9 Anjakan akibat kesan perubahan suhu
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Model-model yang dibuat melalui perisian LUSAS ditunjukkan pada Rajah 6.10,
Rajah 6.11 dan Rajah 6.12.

% LUSAS View: psm-rasuk-masalah enapan.mdl Windeow 1 @lﬂlﬁ

e 2. 9 0.0z 04 .08 .08 . o0mw . o1z . 14 |

L g

Rajah 6.10 Model rasuk akibat kesan enapan pada enapan

% LUSAS View: psm-rasul-misbuilt 1203070 mdl Window 1 lilﬂlﬁ
W, ¢ . =z & & & 0|
oF-
-
N
ol T 4 & 2 1112 13,10 18 20 29 13
T T‘ bl
o
.

Rajah 6.11 Model rasuk akibat kesan ralat pembinaan anggota
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.
% LUSAS View: psm-rasul-temp 120307cmdl Window 1 L = | (5] ﬁ

[ T B B B

W
L

3 4 5 2 4112 136018 20 2118

2

Rajah 6.12 Model rasuk akibat kesan perubahan suhu anggota
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BAB VII

KEPUTUSAN DAN PERBINCANGAN

7.1 Pengenalan

Pada bab terdahulu telah ditunjukkan bagaimana analisis struktur dijalankan
terhadap tiga jenis struktur dengan mempraktikkan kaedah matrik kekukuhan dan
perisian LUSAS bagi menyelesaikan masalah-masalah analisis struktur. Masalah-
masalah analisis struktur yang berkaitan adalah kesan beban kenaan graviti iaitu
beban tumpu dan beban teragih seragam dan kesan beban fabrik iaitu kesan enapan
sokong, kesan ralat pembinaan anggota dan kesan perubahan suhu.

Hasil analisis yang dibuat melalui perisian LUSAS digunakan sebagai
rujukan untuk membuat perbandingan terhadap hasil analisis yang dijalankan melalui
kaedah matrik kekukuhan berdasarkan masalah-masalah yang dikaji. Perbandingan

yang dijalankan meliputi anjakan dan daya tindak balas.

7.2  Perbandingan keputusan analisis

Hasil-hasil analisis yang didapati melalui kedua-dua bahagian iaitu daripada

kaedah matrik kekukuhan dan daripada perisian LUSAS dibandingkan berdasarkan

masalah-masalah yang ingin dikaji iaitu kesan beban kenaan, kesan enapan , kesan
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ralat pembinaan anggota dan kesan perubahan suhu terhadap tiga jenis struktur iaitu

kekuda satah, kerangka satah dan rasuk.

7.3 Perbandingan keputusan analisis kekuda satah

Analisis kekuda satah telah dijalankan terhadap tiga kes masalah iaitu:
e Kes 1: Kesan beban kenaan dan enapan sokong
e Kes 2: Kesan ralat pembinaan anggota
e Kes 3: Kesan perubahan suhu.
Perbandingan dibuat melalui penjadualan agar memudahkan pembaca memahami

dan meneliti dengan jelas perbandingan keputusan yang dibuat.

7.3.1 Kesan beban kenaan dan enapan sokong kekuda

Kekuda satah telah dikenakan beban kenaan sebagai beban tumpu sebanyak
100kN pada sokong 2 pada arah ke bawah pada paksi-y. Selain itu, kekuda ini telah
mengalami enapan pada sokong 4. Jadual 7.1 hingga jadual 7.2 menunjukkan
perbandingan yang dibuat terhadap hasil analisis yang meliputi anjakan dan daya

ricih pada nod.

ANJAKAN PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
Ax (m) Ay (m) Az (rad) | Ax (m) Ay (m) Az (rad)
1 0 -6.283x10~ 0 0 -0.006 0
2 0 7.642x10™ 0 0 -0.007 0
3 0 0 0 0 0 0
4 0 -0.01 0 0 -0.01 0

Jadual 7.1 Perbandingan anjakan pada nod kesan gabungan enapan dan beban

kenaan
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KAEDAH KEKUKUHAN LUSAS
NOD Fx (kN) Fy (kN) Fx (kN) Fy (kN)
1 -106 0 -103 0
2 -30 0 -29.8 0
3 105.6 79.2 103 77.6
4 28.8 21.6 29.8 22.4

Jadual 7.2 Perbandingan daya tindak balas kekuda kesan gabungan beban

kenaan dan enapan

7.3.2 Kesan ralat pembinaan anggota kekuda

Dalam kes ke-2 ini pula, selain mengalami beban tumpu sebanyak 100kN

pada arah ke bawah pada paksi-y, anggota 3 telah dibina terpendek sebanyak Smm

sebelum anggota itu disambungkan kepada kekuda tersebut. Hasil analisis yang telah

dijalankan dipersembahkan melalui jadual-jadual iaitu Jadual 7.3 yang menunjukkan

anjakan yang berlaku pada nod, daya tindak balas dan daya paksi.

ANJAKAN PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
Ax (m) Ay (m) Az (rad) | Ax (m) Ay (m) Az (rad)
1 0 -6.283x10~ 0 0 -0.006 0
2 -0.005 7.642x10™ 0 -0.005 -0.007 0
3 -0.005 0 0 -0.005 0 0
4 0 0 0 0 0 0

Jadual 7.3 Perbandingan anjakan pada nod akibat kesan ralat pembinaan

7.3.3 Kesan perubahan suhu anggota kekuda

Kes ke-3 pula merupakan analisis yang menunjukkan bagaimana anggota-

anggota kekuda satah itu bertindak balas apabila dikenakan beban tumpu sebanyak

100kN pada sokong 2 dan anggota 1 pulamengalami pertambahan suhu sebanyak
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20°C dengan kadar suhu iaitu 1.5 x 107 °C. Jadual 7.4 dan jadual 7.5 memaparkan
perbandingan terhadap anjakan yang berlaku pada nod, daya tindak balas dan daya

paksi.
ANJAKAN PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
AX (m) Ay (m) Az (rad) | Ax (m) Ay (m) Az (rad)
1 0 -6.69x10~ 0 0 -0.00667 0
2 0 -7.23x10” 0 0 -0.00722 0
3 0 0 0 0 0 0
4 0 0 0 0 0 0
Jadual 7.4 Perbandingan anjakan pada nod
Kaedah matrik kekukuhan LUSAS
Nod Fx (kN) Fy (kN) Fx (kN) Fy (kN)
1 -64.2 0 -64.1 0
2 0 0 -69.3 0
3 64.2 48.2 64.1 48.1
4 69.4 52.1 69.3 51.9

7.4 Hasil keputusan analisis kerangka satah

Jadual 7.5 Perbandingan daya tindak balas

Kerangka satah telah dianalisis terhadap ketiga-tiga masalah struktur yang

dikaji.

Analisis kerangka satah telah dijalankan terhadap tiga kes masalah iaitu:

e Kes 1: Kesan enapan sokong

e Kes 2: Kesan ralat pembinaan anggota

e Kes 3: Kesan perubahan suhu.

Perbandingan dibuat melalui penjadualan agar memudahkan pembaca memahami

dan meneliti dengan jelas perbandingan keputusan yang dibuat.




7.4.1 Kesan enapan sokong
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Kerangka satah mengalami enapan menegak sebanyak 40mm pada nod 2. Jadual 7.6

dan 7.7 menunjukkan anjakan dan tindak balas yang terhasil akibat kesan enapan

pada kerangka satah.
ANJAKAN PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
AX (m) Ay (m) Az (rad) | Ax (m) Ay (m) Az (rad)
1 0 0 0 0 0 0
2 -2.2x10" | 3.98x10~ 0.004 0.00022 -0.0398 | -0.00404
3 0 0 0 0 0 0

Jadual 7.6 Perbandingan anjakan pada nod kerangka akibat kesan enapan

DAYA TINDAK BALAS PADA NOD

NOD KAEDAH KEKUKUHAN LUSAS
Fx (kN) | Fy (kN) | Fz(kNm) | Fx (kN) | Fy (kN) | Fz (kNm)
1 29.332 -30.9 -105.85 -29.4 30.8 106
2 0 0 0 0 0 0
3 229.18 | 15.96 38.35 29.4 -30.8 -38.6

7.4.2 Kes 2: Kesan ralat pembinaan anggota

Jadual 7.7 Perbandingan daya tindak balas pada nod

Pada anggota 1, berlaku ralat pembinaan pada anggota dimana ia dibina terpendek

0.Im. Jadual 7.8 menunjukkan perbandingan anjakan pada nod antara kaedah

kekukuhan dan LUSAS.
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ANJAKAN PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
AX (m) Ay (m) Az (rad) | Ax (m) Ay (m) Az (rad)
1 0 0 0 0 0 0
2 0.1233 -4.6047x10" -0.02779 0.1 0.0004 0.0225
3 0 0 0 0 0 0

Jadual 7.8: Perbandingan anjakan pada nod

7.4.3 Kes 3: Kesan perubahan suhu.

Pada anggota 1, berlaku perubahan suhu iaitu dimana anggota 1 mengalami kenaikan

suhu sebanyak 20°C dengan kadar perubahan suhu sebanyak 1.2x107. Jadual 7.9 dan

7.10 menunjukkan perbandingan anjakan dan daya tindak balas antara kaedah

kekukuhan dan LUSAS.
ANJAKAN PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
AX (m) Ay (m) Az (rad) AX (m) Ay (m) Az (rad)
1 0 0 0 0 0 0
2 -1.7726x10° | 6.6209x10° | 3.995x10” | 0.00142 0.000114 -0.0003
3 0 0 0 0 0 0
Jadual 7.9: Perbandingan anjakan pada nod
DAYA TINDAK BALAS PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
Fx (kN) | Fy(kN) | Fz(kNm) | Fx(kN) | Fy (kN) | Fz (kNm)
1 2.36 1.323 2.64 3.01 -1.15 -2.43
2 0 0 0 0 0
3 -2.36 -1.32 5.30 -3.01 1.15 7.55

Jadual 7.10: Perbandingan daya tindak balas pada nod
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7.5 Perbandingan keputusan analisis rasuk

Rasuk yang telah dianalisis ditindaki oleh beban teragih seragam sebanyak 4
kN/m pada anggota 1 dan beban titik sebanyak 10kN pada pada anggota 2. Selain itu,
rasuk ini dianalisis berdasarkan masalah-masalah yang sama iaitu kesan enapan,

kesan ralat pembinaan anggota dan kesan perubahan suhu.

7.5.1 Kesan gabungan beban kenaan dan enapan pada sokong rasuk

Seperti yang telah diterangkan diatas, rasuk telah dianalisis terhadap beban
kenaan yang meliputi beban titik sebanyak 10kN pada anggota 2 dan beban teragih
seragam sebanyak 4 kN/m pada anggota 1. Selain itu, pada sokong 2 terdapat enapan
sebanyak 2mm pada arah bawah pada arah paksi-y. Jadual 7.11 dan 7.12
menunjukkan perbandingan anjakan dan daya tindak balas pada nod antara kaedah

kekukuhan dan LUSAS.

ANJAKAN PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
AX (m) Ay (m) Az (rad) AX (m) Ay (m) Az (rad)
1 0 0 0 0 0 0
2 0 -0.05 5.614x10” 0 -0.05 0.00561
3 0 0 0 0 0 0
Jadual 7.11 Perbandingan anjakan pada nod
DAYA TINDAK BALAS PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
Fx (kN) | Fy(kN) | Fz(kNm) | Fx(kN) | Fy (kN) | Fz (kNm)
1 0 72.49 263.52 0 73.3 263
2 0 45.71 324.43 0 38 324
3 0 148.03 -419.52 0 149 421

Jadual 7.12 Perbandingan daya tindak balas
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7.5.2 Kesan ralat pembinaan anggota rasuk

Anggota 2 telah dipasang terpendek sebanyak 0.1m dan ini menjadikan rasuk ini
mengalami ralat pembinaan anggota. Jadual 7.13 menunjukkan perbandingan

anjakan pada nod, daya tindak balas dan daya dalaman.

ANJAKAN PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
AX (m) Ay (m) Az (rad) AX (m) Ay (m) Az (rad)
1 0 0 0 0 0 0
2 0 -0.05 5.614x107 0 -0.05 0.00561
3 0 0 0 0 0 0
Jadual 7.13 Perbandingan anjakan pada nod
7.5.3 Kesan perubahan suhu anggota rasuk
Struktur rasuk mengalami perubahan suhu pada anggota 2 sebanyak 20°C
dengan kadar suhu, a sebanyak 1.2x10°°C™". Analisis yang telah dibuat diringkaskan
dan dibandingkan dengan analisis perisian LUSAS melalui Jadual 7.14..
ANJAKAN PADA NOD
NOD KAEDAH KEKUKUHAN LUSAS
Ax (m) Ay (m) Az (rad) Ax (m) Ay (m) Az (rad)
1 0 0 0 0 0 0
2 0 0 0.0001225 0 0 0.000123
3 0 0 0.00017705 0 0 0.000177

Jadual 7.14 Perbandingan anjakan pada nod
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7.6 Perbincangan

Setelah menganalisis struktur dengan menggunakan kedua-dua kaedah dan
membuat pembandingan antara kedua-duanya, didapati keputusannya menunjukkan
terdapat persamaan walaupun terdapat perbezaan sedikit. Justeru itu, analisis
menerusi kaedah matrik kekukuhan berjaya dibuktikan melalui kaedah analisis
perisian LUSAS yang merupakan perisian yang sangat bagus dan sering digunakan
dalam menjalankan analisis struktur.

Perbezaan yang berlaku adalah perbezaan dari segi nilai titik perpuluhan
dimana perisian LUSAS menjalankan analisis dengan menggunakan titik perpuluhan
yang amat besar manakala analisis yang dilakukan secara manual melalui kaedah
matrik kekukuhan mempraktikkan pernomboran sehingga 4 titik perpuluhan jika
paling maksimum. Walaupun ia nampak agak remeh, namun ralat sebeginilah yang
menyebabkan berlaku perbezaan keputusan. Namun begitu, perbezaan yang berlaku
adalah tidak kritikal.

Adalah sepatutmya, perbezaan yang diperolehi tidak kritikal kerana secara
asasnya, perisian LUSAS menjalankan analisis berdasarkan kaedah elemen terhingga
dimana kaedah ini diasaskan daripada kaedah kekukuhan. Kaedah elemen terhingga
memudahkan analisis kerana adalah amat sukar dan leceh untuk menganalisis
struktur yang berbentuk kompleks seperti struktur kapal terbang seumpamanya
dengan menggunakan kaedah kekukuhan kerana memerlukan penyelesaian matrik

yang sangat besar dan kompleks untuk diselesaikan.
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BAB VIII

KESIMPULAN

8.1 Hasil kajian analisis

Menerusi kajian ini, tiga jenis struktur yang berbeza dianalisis melalui
penggunaan kaedah matrik kekukuhan terhadap bukan sahaja beban kenaan graviti
yang selalu dilakukan malah dianalisis terhadap tiga jenis beban fabrik akibat
daripada kesan enapan pada sokong, kesan ralat pembinaan anggota dan kesan

perubahan suhu pada anggota struktur.

Seterusnya, analisa yang telah dijalankan melalui kaedah matrik kekukuhan
terhadap tiga jenis struktur ini iaitu merangkumi kekuda satah, rasuk dan kerangka
satah telah berjaya dibuktikan keputusannya menerusi penggunaan analisis perisian
LUSAS. Keputusan yang diperoleh merangkumi anjakan pada nod dan sokong, daya
paksi, daya tindak balas dan momen. Keputusan ini telah berjaya dibuktikan melalui

analisis perisian LUSAS. Maka, dengan itu tercapailah objektif dan skop kajian ini.

Melalui kajian ini, diharapkan para pembaca akan lebih memahani dengan
mendalam tentang analisis yang dijalankan dalam perisian. Hal ini demikian, tanpa
pemahaman yang mendalam tentang analisis struktur terutamanya penggunaan
kaedah matrik kekukuhan dimana kaedah asas bagi analisis struktur, para jurutera

atau para analisa struktur yang mempraktikkan penggunaan peisiian akan
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menghadapi kesukaran dalam proses analisis dan menghadapi risiko kegagalan

struktur.

Adalah menjadi tanggungjawab kepada pengguna perisian komputer analisis
struktur untuk memahami prinsip kerja sesuatu perisian supaya perisian tersebut
dapat dipraktikkan dengan cekap dan berkesan dan seterusnya sesuatu struktur yang
kompleks dapat dimodelkan dan dianalisis dengan tepat. Sekiranya menggunakan
perisian analisis tanpa pemahaman yang cukup, akan berlaku risiko dimana para
analisa atau para jurutera tidak mengetahui dan menyedari berlaku kesilapan analisis

dan kegagalan struktur yang bakal menimpa.

8.2 Cadangan kajian seterusnya

Kajian ini seharusnya diteruskan lagi bagi memantapkan lagi pemahaman
tentang analisis struktur. Hal ini demikian, terdapat banyak lagi jenis struktur yang
boleh diketengahkan untuk dianalisis. Malah, banyak lagi sifat-sifat struktur yang

masih berpotensi untuk diketengahkan bagi dianalisa.

Oleh itu, bagi kajian seterusnya adalah dicadangkan supaya kaedah matrik
kekukuhan ini dikaji bagi struktur ruang atau tiga dimensi terhadap beban kenaan
graviti seperti beban tumpu dan beban teragih seragam dan beban akibat kesan
enapan pada sokong, kesan perubahan suhu dan kesan ralat pembinaan anggota.
Sebagai contoh adalah struktur kekuda ruang dan kerangka ruang. Selain itu, struktur

grillage atau struktur grid juga dicadangkan untuk diketengahkan bagi tujuan kajian.
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